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Kick Start in 4
2
/2 examples! 

 

Several examples are given to explain how to type equations in an efficient manner. Here we 

assume that default settings are used. 

 

 

EXAMPLE 1:  We want to write the famous: E=mc
2
. 

 

 

STEP 1 –  Mouse-click anywhere at the document area 
 

 

 
 

 Click anywhere at the empty area. The following should happen: 

- the blinking cursor will appear (a vertical blue blinking line) 
- the mouse arrow turns into a black heart-like shape 

 this tells you that the Typing mode is now active. 

 
 Move that black ugly mouse pointer away, not to block your view. We will use keyboard. 

 

 

STEP 2…5 –  On your keyboard type: E=mc 
 

 
 

 As you click a letter, it appears on the screen and the blinking cursor moves to the right. 

 

 

STEP 6 –  On your keyboard make the following keystroke: ALT+2 
 

 
 

By pressing the ALT+2 keystroke, you squared the ‘c’.  
 

In Math-o-mir, one way to type exponents is by holding down the ALT key as you type. See more here… 
 

 

STEP 7 –  Press the ESC key to exit the Typing mode 
 

 

 
 

The blue blinking cursor will disappear, and the mouse pointer will revert to the healthy white arrow.  

 

With the ESC key you immediately exit the Typing mode. Another way to exit the Typing mode is to right-

mouse-click anywhere at the empty document area. 
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EXAMPLE 2:  We want to write: s=1/2 x   (Concentrate on steps 4...8) 

 

 

STEP 1 –  Mouse-click anywhere at the document area 
 

The Typing mode starts. 

 

STEP 2,3 – On your keyboard type: s= 

 

STEP 4 –  On your keyboard type the slash key, twice: // 
 

 
  

In Math-o-mir, two slashes are automatically converted into the true fraction. The blinking cursor will 
automatically move into the numerator. The denominator will show an empty box. 

 

STEP 5 –  On your keyboard type: 1 
 

 
 

STEP 6 –  On your keyboard press the ENTER key 
 

 

 
 

The cursor moved into the denominator. The Enter key can be used to quickly move the cursor to the next 

logical entry point. The next logical entry point might be an empty box within the same element (as in this 
example), or it might be the position just behind the current element (see Step9 below). 

 

A more general way to move the cursor around your equation would be by using keyboard arrow keys (up, 
down, left, right). For example, instead of the Enter key, here we could hit the arrow-down key twice to move 

the cursor into the denominator. 

 

STEP 7 –  On your keyboard type: 2 
 

 
 

STEP 8 –  On your keyboard press the ENTER key 
 

 
 

The blinking cursor is moved to the baseline again. [You could use arrow-right or arrow-up keys to achieve the 

same.] 

 

STEP 9 – On your keyboard type: x 

 

STEP 10 – Press the ESC key to exit the Typing mode 
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EXAMPLE 2, again: We want to write: s=1/2 x  (Concentrate on steps 4 and 5) 

 

This time we will use a faster method to enter simple fractions. 

 

 

 

STEP 1 –  Mouse-click anywhere at the document area 
 

The Typing mode starts. 

 

STEP 2,3 – On your keyboard type: s= 

 

STEP 4 –  On your keyboard type: 1 
 

 
 

STEP 5 –  On your keyboard type the hash key: # 
 

 
The fraction was created. The number one is moved into the numerator, while the cursor is moved into the 

denominator. 

 
With the # key (or, alternatively, the grave accent ` key) you can insert the fraction line ‘under’ the last typed 

element. You can, in fact, hit the # key more than once to ‘suck in’ more than one element into the numerator. 
 

 

STEP 6 –  On your keyboard type: 2 
 

 
 

STEP 7 –  On your keyboard press the ENTER key 
 

 
 

STEP 8 – On your keyboard type: x 

 

STEP 9 – Press the ESC key to exit the Typing mode 
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EXAMPLE 3:  We want to write:  2 + sin π + 2  (Concentrate on steps 4...7) 

 

 

 

STEP 1 –  Mouse-click anywhere at the document area 
 

The Typing mode starts. 

 

STEP 2,3 – On your keyboard type: 2+ 

 

STEP 4 –  On your keyboard type the following command: \sin 
 

 
  

While in Typing mode, you can cast some commands. Every command starts with the backslash character. 

Examples are: \sin, \cos, \tg, \sqrt, \ln, \int, \sum, \infty, \kg... Using a command, you instruct Math-o-mir to 

insert specific symbol, function or a measurement unit. 
 

A command is executed by pressing the space bar or the Enter key (see the next step). 

 

STEP 5 –  On your keyboard press the Space Bar (or the ENTER) key 
 

 
 

By pressing the Space bar or Enter the command is executed. Math-o-mir inserted sinus function and moved 
the cursor into the function argument box. 

 

STEP 6 –  On your keyboard rapidly hit the ‘p’ key twice: pp 
 

 
 

Rapid double letter sequences (within a second) are converted to Greek symbols. For example ‘aa’ sequence is 

converted to the Greek alpha character. ‘GG’, for example would be converted to uppercase Greek gamma (Γ). 

 

STEP 7 –  Press the ENTER key (or press the right-arrow key) 
 

 
 

Surprise! Why did we have to hit the Enter key? Because we wanted to move out of the sinus function 

argument! Now our blue blinking cursor is back on the main course. If we continued typing ‘+2’ inside the 
function argument, we would get the following: 

 

 
 

Notice that while the cursor was still inside the function argument, the Math-o-mir framed the function 

argument with dashed gray line. This can help you understand where exactly your cursor is placed. 

 

STEP 8 –  On your keyboard type: +2 

 

STEP 9 – Press the ESC key to exit the Typing mode 
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EXAMPLE 3, again:  We want to write:  2 + sin π + 2    (Concentrate on steps 4, 5 and 7) 

 

This time we will use the dot (period) key to create the function. This is a faster method than the 

command entry method and is a preferred method to enter known (common) functions. 

 

 

STEP 1 –  Mouse-click anywhere at the document area 
 

The Typing mode starts. 

 

STEP 2,3 – On your keyboard type: 2+ 

 

STEP 4 –  On your keyboard type: sin 
 

 
  

 

STEP 5 –  On your keyboard hit the dot (period) key: . 
 

 
 

By pressing the dot key, Math-o-mir examines several last letters that you entered, and if it looks like a 

common function name, it creates that function. Otherwise, if no common function name is recognized, it only 

converts the single last letter into a single-letter function (for example ‘f.’ will be converted to the f( ) 
function). 

 

STEP 6 –  On your keyboard rapidly hit the ‘p’ key twice: pp 
 

 
 

 

STEP 7 –  Hit the plus key twice: ++ 
 

 
 

Using the ‘+ +’ sequence, the plus operator was inserted outside of the function argument. In the Math-o-mir 

you can use the ‘+ +’,  ‘- -‘, or ‘= =’ sequences as a faster way to type ‘Enter +’, ‘Enter –‘ or ‘Enter =’ 
sequences. [ Tip: every so often you will forget to hit the Enter key to exit the function argument and thus you 

will mistakenly type a ‘+’ (or ‘-‘ or ‘=’) operator inside the function argument. Instead of using the backspace 

to delete that operator, you can just type it once more to move it outside function argument. ] 

 

STEP 8 –  On your keyboard type: 2 

 

STEP 9 – Press the ESC key to exit the Typing mode 
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EXAMPLE 4:  We want to write:  (x+y)sqrt(2)  (Concentrate on steps 2...5) 

 

 

 

STEP 1 –  Mouse-click anywhere at the document area 
 

The Typing mode starts. 

 

STEP 2 –  On your keyboard type: ( 

 

 
 

When you type in the left bracket, the Math-o-mir inserts the parentheses object and moves the cursor inside it. 

 

STEP 3 –  On your keyboard type: x+y 
 

 
  

 

STEP 4 –  On your keyboard press the ENTER key 
 

 
 

Cursor moved outside parentheses. Instead of Enter, you could also hit the right-arrow key or the ‘)’ key. 

 

STEP 5 –  On your keyboard make the following keystroke: CTRL+R 
 

 
 

By pressing CTRL+key, an accelerator is activated. By default, the CTRL+R generates the square root sign.  
[ You can freely define accelerators for any toolbox item – right-mouse-click to toolbox item, and define the 

desired accelerator keystroke. You can then save your settings by choosing 

Options->Save settings->Save as default. ] 
 

[ Alternatively, instead of using the CTRL+R accelerator to insert square root sign, you could cast command 

\sqrt for the same purpose. ] 

 

STEP 6 –  On your keyboard type: 2 
 

 
 

 

STEP 7 – Press the ESC to exit the Typing mode 

 
 

 

 

 

Bravo!  

 

If you understood above examples, then you are ready to use Math-o-mir. 
More advanced examples here… 
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Welcome to the Math-o-mir users manual 
 

Here you will learn basic moves to deal with the Math-o-mir software. But first, what is Math-o-

mir good for? It can be useful to engineers, students and other people that want to make quick, 

informal mathematical analysis of some problem. I like to say that Math-o-mir main competition is 

‘pencil and back of an envelope’. Although writing math in Math-o-mir is certainly not that simple 

as with pencil, there are tools in Math-o-mir that can justify the initial effort. 

 

 

The main screen layout 
 

The main screen layout is quite simple - the main menu and the toolbar above, the toolbox to the 

left, while the rest of the screen is the document area. The overall look is intentionally made 

humble because Math-o-mir is only a notepad intended for quick, informal math. 
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The closer look at the Toolbox 

 

The left-side-toolbox has its ‘header’ part - those two ‘U’ and ‘M’ fields that are used to activate 

different fonts. The rest are math ‘building blocks’ that you can put into your document and hand-

drawing tools. To pick-up any math item or to select any drawing tool, simply click at it… Just 

below the toolbox, there is also the color box where you can choose colors and line widths when 

are using drawing tools. 

 
If you hover a mouse pointer above a toolbox item for some time (<1sec), the corresponding 

subtoolbox containing additional items will open. You can also click at the shadowed triangle area 

at the bottom-right corner of any toolbox item to open its subtoolbox instantly. (To close an opened 

subtoolbox, simply move the mouse pointer far away from it or hit the Esc key.) 

 
Note: every item in a subtoolbox has a shadowed triangle area at the upper-left corner. A click on it will transfer the 

associated subtoolbox option into the main toolbox for easier subsequent access. This way you can arrange your 

toolbox to some extent. 

 

 

Keyboard accelerators – a fast ways to access toolbox items 

 

You can right-click at any toolbox or subtoolbox item to open the accelerator pop-up menu.  
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From this pop-up menu you can associate an accelerator keystroke to that particular item. There are 

three types of accelerators. 

- CTRL+ accelerators 

- Double-stroke accelerators 

- Easycast accelerators 

 

The CTRL+ accelerators always use CTRL+key or CTRL+SHIFT+key combinations. The 

advantage is that CTRL+ accelerators can be used even while you are typing a plain text, or even if 

the Typing mode is not active at all. Further advantage is that you can associate CTRL+ 

accelerators even to drawing tools or fonts. To associate a CTRL+ accelerator, just choose the 

desired combination from the popup menu. 

 

The double-stroke accelerators work only while you type math, not while you type a plain-text. 

Also, double-stroke accelerators are timed – you must double-stroke the key quickly in order to 

trigger the accelerator (<750 millisecond). To associate a double-stroke accelerator, just click at the 

desired double-stroke combination from the popup menu. 

 

Note: double-strokes are by default used to enter Greek symbols. If you, for example, define the 

accelerator for the ‘dd’ double-stroke, then you will not be able to easily enter Greek delta letter 

any more. You will have to use the \delta command instead. 

 

Note: CTRL+ and double-stroke accelerators that are already in use are displayed using somewhat 

pale text, but you can still choose them if you wish to redefine the accelerator. 

 

The easycast accelerators work similar to the double-stroke accelerators, but you can define 

strokes freely. Also, easycasts are not timed so you can type them slowly. To define an easycast 

accelerator click on the the “Easycast..” option from the popup menu. A dialog box, similar to 

following, will open: 

 
 

The keystroke sequence used or easycasts should be no longer than eight characters. Also, not all 

combinations are possible – for example if you already defined easycast sequence “sin”, then you 

cannot define the “sinus” or any other sequence that starts with “sin”. Neither can you define “si” 

sequence any more. 

 

How to use easycasts? Suppose that you assigned “sin” easycast sequence to the sin() function in 

the toolbox. When you type your equations, whenever you type the “sin” on your keyboard, the 

sin() function will be inserted.  
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Customizing the toolbox 

 

You can add new items into the left-side-toolbox. It may be that you use the expression 

very often, for example. It takes time and effort to type down such an expression. Therefore, it 

would be handy if you could somehow keep that expression in the toolbox for easier access. This 

way you could even define an accelerator keystroke to it… You should do the following: 

 

- Create the expression anywhere in the document area 

- Click on it to pick it up 

- Carry it to the toolbox (or subtoolbox) 

- Right-mouse-click on the toolbox (or subtoolbox) 

 

Note that new items are always appended at the end of toolbox/subtoolbox… In the picture below 

we appended the expression into the ‘square root’ subtoolbox. Sure, complex expressions 

cannot be displayed very clearly as the space is limited. 

 

 
 

You can also insert hand-drawings into the toolbox using the same procedure. Just create a hand-

drawing somewhere in the document area, pick it up and carry it to the (sub)toolbox – then right-

mouse-click to drop it. 

 

Note: The size of the toolbox can be changed by using “View->Toolbox and context menu” in 

four steps: small, medium, large and very large. In addition the ‘auto-resize’ option is available. 

 

After you defined your toolbox look and feel, you can save its configuration by using the following 

option from the main menu: “Options->Save Settings->Save as default”. This way Math-o-mir 

will use the defined configuration every time you start it. 

 

 

The closer look at the Toolbar 

 

The top-toolbar can be used to quickly execute simple commands like save, cut, copy, paste… 

Note however that all options available from the top-toolbar are redundant and are also available 

by other means: from the main menu, from the side-toolbox, using keyboard shortcuts... Therefore, 

if you feel that the top toolbar steals too much of your screen area, you can remove it by 

unchecking: “View->Toolbox and context menu->Show Toolbar” 
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A disabled toolbar button is displayed in pale gray color and you cannot click it. For example, the 

‘cut’ and ‘copy’ buttons will be disabled when there are no objects selected.  

 

Some toolbar buttons are two-state, meaning that by mouse click you can toggle them between an 

active or an inactive state. In the active state such buttons will have the purple check-mark 

displayed. For example the ‘grid’ option can toggle between ‘grid-on’ and ‘grid-off’ states. 

 

Due to restricted screen size, not all options are displayed all the time. The toolbar will 

automatically reconfigure according to the context: 

 
- when the Typing mode is activated, the font size, text orientation, headline conversion and text-justification 

options might be present 

- when some items are selected, alignment, group and mirror options might be present 

 

The toolbar also reconfigures according to the main window width. If more width is available, 

some text options will be present even if the Typing mode is not active.  

 

You can get the tooltip help text for any toolbox item if you hold the mouse pointer steady above it 

for some time (cca 1.5 sec).  

 

 

 

The closer look at the document area – the document navigation 

 

The document area is an endless space that has white and grayed regions. The white regions 

represent the paper sheets, but you can write your math even outside, on the grayed area. However, 

when you send your artwork to a printer, only the math within the white area will be printed. 

 

The size and orientation of the white area (paper) can be adjusted using: View->Page menu. 

 

 

Zoom-in and zoom-out 
 

To zoom-in or zoom-out the document view you can use three methods:  

• Ctrl key + mouse-wheel,  

• right-mouse-button + mouse-wheel 

• F2/F3 keys.  

 

If you select ‘Options->Mouse->Mouse-wheel function: Zoom in/out’, then you will be able to 

use the mouse wheel for zoom (instead of scrolling) even without holding down the Ctrl key. 
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It is possible to use the F1 key to readjust zoom level back to 1:1. To make such F1 usage possible, you must check 

‘Options->Keyboard->Use F1 to set zoom level to 100%’. By default, the F1 key is used to display the Handy Help. 

 
Advanced - When you use the mouse wheel to zoom-in, you will typically first point your mouse pointer to the 

document area you want to zoom at and then turn the wheel. You can use the same trick even with the F2 key, but it 

will only work if you actually moved your mouse pointer shortly (one second) before the F2 key is pressed. Otherwise, 

if mouse pointer was not moved for a longer time, the F2 key will not respect your mouse pointer position while 

performing the zoom-in. 

 

 

 

 

Scroll up and down 
 

To scroll the view, you can use the mouse wheel (vertical scroll only), use scroll bars, or you can 

right-mouse click on document area and drag your mouse. You can even scroll the view by using 

keyboard arrow keys (only when the Typing mode is not activated) or PgUp/PgDown keys. 

 

Note: even if you redefined the function of the mouse wheel to use it for zoom in/out, you can still 

use the wheel for scrolling if you hover the mouse pointer over the vertical scroll bar while rolling 

the wheel. Alternatively you can hold down the right-mouse-button while you are rolling the wheel 

(holding down the right-mouse-button temporarily toggles the mouse wheel function). 

 

Note: you can change the mouse vertical scrolling speed and you can reverse scrolling direction by 

checking appropriate options from the Options->Mouse menu. 

 

 

Quick document view and navigation 
 

If you right-mouse-click at the vertical scrollbar, the Math-o-mir will show your entire document 

squeezed into little tiles. One tile represents a single page. This works best for documents up to 25 

pages. 

 
 

You can mouse-click at any tile to quickly move to that location. Or you can right-mouse-click (or 

hit the Esc key) to close the tiles view.  

 

While tiles are shown, you can enlarge any tile by clicking at the ‘+’ sign. Note that within tiles, 

any headline text is displayed with unproportionally large font so that it can be read. 
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The Presentation mode vs the Edit mode (and the art of printing) 

 

Your artwork can be displayed in any of two modes: the Presentation mode and the Edit mode. 

When you start the software, the Edit mode is active. To toggle between the Edit and Presentation 

mode, hit the F5 key, or use the “View->Presentation Rendering” menu option. 

 

When the Presentation mode is active your equations will look better, but will be harder to edit. 

When the Presentation mode is active, you can even further improve the look of your equations by 

activating the Halftone rendering option: check the “View->Halftone Rendering”. Note however 

that the Presentation rendering, especially when the halftone smoothing is enabled, is CPU hungry 

and the software responsiveness might become unacceptable. 

 

 

       
 

The above example shows the same equation displayed in the Edit mode (left), Presentation mode 

(center) and Presentation mode with halftone smoothing (right). Notice that in the Edit mode there 

exist more space between the integral sign and ‘x’ (also more space between the ‘dx’ and the equal 

sign) – because of such enlarged spacing, formulas are easier to edit in the Edit mode. Also, the 

Edit mode displays functions and differentials in a bit greenish color. Further, the integral sign and 

parentheses are simplified to gain faster screen refresh and thus better responsiveness. 

 

If you are not specifically orientated to printing (publishing) your document, I suggest you that you 

do almost all of your editing in the Edit mode. It is very easy to toggle between Edit and 

Presentation mode by hitting the F5 key. 

 

Still you can make basic editing of your equations in the Presentation mode and you will do this 

when you prepare your document for printing. In comparison to the Edit mode, the Presentation 

mode has one major advantage when it comes to printing – it keeps relative object sizes fixed 

providing better WYSIWYG experience. Take a look at following examples: 

 

 
 

In the above 4 examples we have an equation that has some hand drawing objects drawn over it 

(the red rectangle and the red arrow). Two examples to the left show the Edit mode in two different 

zoom levels. As you can see, the relative size of the equation relative to the graphics is not kept 

constant – as a result, the arrow is not clearly pointing at the differential sign in the low-zoom 

example. 

 

On the other hand, as it can be seen in two examples to the right, the relative size of the equation 

compared to the size of graphics is kept constant in the Presentation mode. It will also be the same 

during printing. 
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At a low zoom level the readability of text and equations in the Edit mode can be better than in the 

Presentation mode because the between-character spacing is optimized for reading (that is, inter-

character spacing better matches the font size). 

 

When you print at a high-resolution printer, you might obtain better result if you don’t use the 

Halftone rendering mode. The Halftone rendering is optimized for the display screen. 

 

When you send your document to printer, it will be rendered in either Edit mode or Presentation 

mode, whatever is currently active. Take care to switch the mode (using F5 key) to one you prefer 

before you print the document!  

 

 

Page numbering 

 

Page numbering options can be found in the ‘View->Page->Page Numbering’ menu. You can 

choose from three different page numbering styles. You can choose the position of the page 

number – by default the page number is positioned at the top-center of every page. Finally, you can 

choose to leave the first page non-numbered. 

 

 
 

Note: Some numbering styles will show the ‘number of pages’ for the document. Because in Math-o-mir the number of 

pages is not strictly defined (a document has ‘infinite’ number of pages) the value displayed for the ‘number of pages’ 

equals to the last page that is not entirely empty. 
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Handling your equations with mouse 
 

First, it is good to know about shape and color of mouse arrows (pointers). 

 

  - windows standard white – when mouse is in ‘free’ mode ready to start various actions 

 

 - windows standard black – when you carry something around with your mouse. The carried 

object is usually seen being towed by the mouse pointer.  

 

 - heart-like black – when the Typing mode is active. The blinking keyboard cursor, the blue 

vertical line, should be visible somewhere. Note that you cannot ‘carry’ 

anything with this pointer - as soon as you pick up anything, this will be 

transferred to where your blinking cursor is. 

 

 - pen-like white – when a hand-drawing tool is selected and ready for drawing 

 

Anyway, the standard white mouse arrow is the beginning point in most examples here. If your 

mouse arrow looks any different, press the ESC key until it becomes white. 

 

Touching expressions and expression elements 

 

Suppose that you entered formula E=mc^2 using keyboard, and now you want to examine or edit it 

by mouse.  

 
 

When you move (hover) your mouse pointer over the formula, you will notice that it reacts to it by 

changing color to blue. For example if you moved the mouse pointer above the ‘m’ letter, then the 

‘m’ will turn blue – the ‘m’ is touched. 

 

 
 

By pointing at the right spot, you can touch various parts of your expression. For example: 

 
Touching what Where to point mouse Result 

The ‘c’ variable At the ‘c’ 

 
The ‘2’ exponent At the ‘2’ 

 
The ‘c^2’ expression Just below ‘2’, or just above ‘c’ 

 
The ‘=’ operator Left half of the ‘=’ sign 

 
The ‘=’ operator and everything after Right half of the ‘=’ sign 

 
The whole equation Just below or just above the 

equation. Or at the ‘moving 

dot’ 
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With experience, you will learn exactly where to point the mouse arrow to touch any desired part 

of an expression. Additional examples given bellow will speed up your learning process: 

 

 

 

Pointed at the fraction bar 

 

Pointed just below the numerator expression (just above the fraction bar) or 

just above the numerator expression. 

 

Pointed at the right half of the ‘+’ sign. (Pointing at the left half of the plus 

sign would select only the plus sign itself). 

 
Pointed at the bracket (either left or right) 

 
Pointed just below or above the expression contained inside parentheses. 

 
Pointed just below or above the expression, but in portion outside 

parentheses. 

 

Pointed at the square root sign 

 

Pointed just below or above the expression under the square root sign 

 
Pointed at the sinus function 

 
Pointed just below or just above the expression contained inside the sinus 

function argument (that is, just below or above the ‘πx’). 

 

 

Multi-touching 

 

You can also multi-touch. That is, you can touch several elements even if it is not possible to touch 

them by pointing mouse at one single point. You do this by holding down the SHIFT key or the 

left-mouse button while moving your mouse arrow over the equation. Look at the following 

examples: 

 

 Mouse is pointed at ‘b’, then the SHIFT key (or left mouse button) is 

pressed and held while mouse is carefully moved to the ‘d’. 

 
Mouse is pointed at the ‘2’, then the SHIFT key (or left mouse button) is 

pressed and held while mouse is carefully moved to the ‘b’. 

 

Mouse is pointed at the fraction bar, then the SHIFT key (or left mouse 

button) is pressed and held while the mouse is carefully moved to the ‘C’. 

 

Instead of holding down the SHIFT key when multi-touching, in most cases you can simply click 

and hold down the left mouse button key while dragging the mouse pointer over equation elements 

– that is, you can perform the click-and-drag over elements to touch them.  

 

You can also use the quick multi-touch feature. To use it, you must right-click your mouse at an 

insertion point. To learn more about insertion points and the quick multi-touch feature, please read 

the next chapter.  

 

Operations on touched element(s) 

 

Once you touched some element(s), you can do several things: 

  
- left mouse click – to ‘pick up’ the selection (if nothing was carried by the mouse) 

- left mouse click – to replace the selection with whatever is carried by the mouse 
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- right mouse click – to display the context popup menu 

- keyboard DEL key – to delete the selection 

- keyboard CTRL+X keystroke – to delete and ‘pick up’ the selection 

- keyboard CTRL+C keystroke – to ‘pick up’ the selection (the same as left mouse click) 

- keyboard CTRL+V keystroke – to replace the selection with whatever is carried 

- any keyboard character – to replace the selection with the typed character 

- keyboard F9 key – copies the bitmap image of the selection into the windows clipboard 

- keyboard F8 key – writes (saves) the bitmap image of the selection to hard disk. 

- keyboard F6 key – copies the LaTeX code of the selection into windows clipboard 

 

Touching insertion points 

 

You probably noticed that when you point your mouse pointer in between elements, some thin 

vertical blue line appears. It is called the insertion point. 

 

In the table below you see all the existing insertion points in the E=mc^2 equation: 

 

 
In front of the ‘E’ variable (that is, in front of the whole equation) 

 
Between the ‘E’ and the ‘=’ 

 
Between the ‘=’ and ‘m’ 

 
Between the variable ‘m’ and expression ‘c^2’  

 
After the variable ‘c’ (but inside the exponent function base) 

 
In front of the ‘2’ exponent 

 
After the ‘2’ exponent 

 
After the ‘c^2’ expression (that is, at the end of the whole equation) 

 

Additional examples below: 

 

 
In front of the ‘x’ variable, obviously inside the sinus function argument (Math-o-

mir doesn’t display the dashed frame) 

 
After the ‘x’ variable, but still inside the sinus function argument. The dashed 

frame is displayed because otherwise one could not tell if the insertion point is 

inside or outside function argument. 

 
Between the ‘sin x’ expression and the ‘+’ sign. Outside the function argument. 

 

Even more examples (advanced, brain-killer ones): 

 

 
In front of the ‘x^2’ expression, inside sinus function argument 

 
After the ‘x’ variable, inside the exponent function base 

 
After the ‘x^2’ expression, inside sinus function argument 

 
In front of everything 

 
After everything. 

As you can see, it can get quite complicated with function compositions. Experience is needed. 
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Tip:  It is easier to aim at an insertion point if you hold the ALT key while aiming with the mouse. While the ALT 

key is held down, your mouse pointer will not touch math elements, but only insertion points. This is useful if 

you don’t want to miss the insertion point during low zoom level. 

 

Once you ‘touched’ an insertion point you can do several things: 

 
- left mouse click – starts Typing mode at this point (if nothing was carried) 

- left mouse click – inserts at this position whatever is carried by the mouse 

- CTRL+V – inserts at this position whatever is carried by the mouse 

- any keyboard character – inserts the character at this position 

- right mouse click – used for quick multi-touch. All elements (around the insertion point) on the same operator 

precedence level gets touched. Context menu then opens where you can chose actions like cut or copy. See the 

advanced section below for quick multi-touch examples. 

 

 

 

Advanced – The quick multi-touch explanation: 

 
The quick multi-touch is performed by right-mouse-click at an insertion point. 

 

 

Insertion point 

Quick multitouch 

result (right-click) 

 

Explanation 

  As this insertion point is found at multiplication 

precedence level, the selection extends to ‘2cd’. 

  As this insertion point is found at addition precedence 

level, the selection extends to ‘ab+2cd’. 

  As this insertion point is found at ‘equal’ precedence 

level, the whole equation is selected. 

 

It all depends, inside what operator level was the insertion point that was right-clicked. The 

selection will extend to cover all elements of that operator precedence level.  

 

The ‘newline’ insertion point 

 

There is another insertion point that is displayed when mouse pointer is pointed just below the last 

line of a plain-text object (or a multi-lined math object), at its left edge. You can click at this 

insertion point to start a new line for that text/math object. 
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Pick-up, Carry and Place-down action 
 

Once you know how to touch the desired part of equation/expression. You can easily pick it up, 

carry it away and place it down wherever you want. 

 

Pick-up 

 

(Notice that the ‘pick-up’ term is somewhat misleading. With a simple mouse-click at an object, 

you actually don’t lift it up, but you create a copy of this object that you then can carry away.) 

 

Touch elements you want and click the left mouse button. Two things will happen. 

 

1. The cursor will change its color from ‘standard white’ to ‘standard black’ 

2. The object that you picked up are now dragged with your mouse cursor. 

 
Instead of the simple mouse-click, you can also long-mouse-click at touched math elements (click 

and hold the button down for more than about 0.5 seconds). This will cut (delete) the original. 

 

Alternative ways for pick-up are CTRL+X and CTRL+C keyboard keystrokes. 

 

Carry 

 

Simply move your pointer to the point where you want to place-down. The object that you picked 

up will be towed behind the pointer whenever your pointer goes. 

 

 
 

If you want to throw away whatever you are carrying, either hit the ESC key, or just right-mouse-

click anywhere at empty document area. The mouse arrow will return to its white color. 

 

Advanced: you can even start two instances of Math-o-mir and then carry objects from one 

instance to the other one. 
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Place-down 

 

You can place down at following places: 

 

1. Over touched objects – selected objects will be replaced with whatever you carried 

 

How to do it? Use your black mouse arrow to touch elements of an equation. Then click the 

left mouse button and touched elements will be replaced. 

 

 

In this example, the ‘sin 2pi’ is about to be replaced 

with ‘cos(pi/2-2pi)’. The result will be  

‘x+cos(pi/2-2pi)+v’ 

 

2. At the insertion point – whatever you carried will be inserted at the insertion point 

 

How to do it? Use your black mouse arrow to ‘touch’ insertion point of an equation. Then 

click the left mouse button and you will insert here. 

 

 

In this example, the ‘x
2
’ is about to be inserted after 

the ‘b’ variable. The result will be ‘a+bx
2
+c’ 

 

3. At empty document area – the new object will be created from whatever you carried. 

 

How to do it? With your black mouse arrow simply left-click anywhere on the empty 

document area. 

 

In this example, the ‘x+sin 2pi +y’ expression will be 

placed at the empty document area forming the new 

separated equation object. 

 

 

4. ‘Around’ touched objects – it is called ‘implanting’ and is very useful when understood 

 

How to do it? Use your black mouse arrow to touch elements of an equation. Then click the 

right mouse button. From the context menu, click at desired spot (insertion point) of the 

expression displayed in the ‘implanting’ section... See example below: 

 

In this example, the empty fraction carried by mouse 

is to be implanted ‘under’ the ‘y’ variable... Click the 

right mouse button after you touched the ‘y’. 

 

In the context menu, in the ‘implanting’ section,  

touch and left-mouse-click the insertion point at the 

numerator. 

 

Element(s) that you touched in previous step will be 

inserted exactly at this point. 

 

The result is shown on the picture. The empty fraction 

is implanted ‘under’ the ‘y’ variable.  

 

 

Alternative way of placing-down is using the CTRL+V keyboard keystroke. The difference is that 

whatever you carried stays in your hands, so with CTRL+V you can make multiple place-downs. 
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EXAMPLE – “Pick-up, Carry, Place-down” action 

 
Suppose that there are two separate equations in your document. We want to copy part of one equation into the other 

one. 

 
 
STEP 1 – Touch (select) the whole right part of the first equation. You do this by the multi-touch action – point on ‘a’, 

press and hold the SHIFT key while carefully moving the mouse to the root sign.  

 

 
 

 The alternative way to make the same selection is to mouse-click at the ‘a’ and then, holding down the 

mouse button, move the pointer to the root sign. Once you made the selection this way, you should release 

the button, but do not move your mouse pointer much any more because your selection might deselect. 

 

 The third alternative to make the same selection would be by the quick multi-touch: right mouse click at 

an insertion point between ‘a’ and ‘+’ (or between ‘+’ and square root) and then choose ‘Copy’ from the 

context menu. If you used this method then you should jump directly to the Step #3.  

 

STEP 2 – Left mouse click to pick up touched object (then you may release the SHIFT key that you were holding.) 

 
STEP 3 – Picked-up objects are now carried with the mouse. Move them toward the ‘S’ variable in the second 

equation. 

 
 
STEP 4 – Touch the ‘S’ variable in the second equation while still carrying your load. 

 

 
 

STEP 5 – Left mouse click to replace the touched ‘S’ with your carrying load. 

 

 
 

 

Note that the ‘Pick-up, Carry, Place-down’ is exactly what happens when you take an object from 

the toolbox and place it into your document. 
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The moving dot – moving objects around document 

 

Did you notice a small rectangle at the bottom-left corner of any equation/expression in your 

document? The rectangle becomes visible when you move your mouse arrow near it. This is called 

the ‘moving dot’ and is used to move your equations around. 

 

 
 

The moving dot becomes visible (white) when you point the mouse arrow at the bottom of the 

equation. It becomes black (selected) when you point the mouse arrow directly above it. 

 

When it becomes black you can click and hold left mouse button and move the equation around 

with mouse. This is a handy way to move one single equation. 

 

Tip: If, for whatever reason, you need to touch the whole equation, pointing your mouse at the 

moving dot is usually the easiest way. 

 

Working with selections 

 

You can select one or more equations by drawing a selection frame around them. You do this by 

performing click-and-drag action with your mouse. You must click at empty document area, and 

then stretch the selection frame around objects that you want to select. 

 

 
After you release the mouse button, all objects inside the selection frame will become selected. 

 

 
 

Selected objects are displayed in blue color on a light-blue background. There are also four red 

rectangles at selection envelope corners. 

 

With selections you can: 
- move selections around your document – click-and-drag at any selected object to move them all together. 

- stretch/resize selected objects – click-and-drag at any red rectangle (Hold down the Shift key to keep the aspect 

ratio. Alternatively, you can hold both mouse buttons, left and right, to keep the aspect ratio.) 

- rotate selected objects (drawings only) – right-click-and-drag at any red rectangle 

- cut/copy/paste/delete selected objects – use menu, or keyboard (CTRL-X, CTRL-C, CTRL-V, DEL) 

- display the context menu with more options – right click at any selected object. From the context menu you can 

resize, group/ungroup, lock, align. For hand-drawing objects you can also rotate, stretch and mirror. 
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You can change the color of selected object by clicking at the desired color from the color box. 

Line widths for selected hand-drawings can also be changed this way. 

 

 
 
Note: Selections have precedence to touched objects. When there are objects selected, the CTRL-X, CTRL-C, CTRL-

V and DEL keys will act on selections, not on touched objects. 

 

To deselect everything, either press the ESC key, or just mouse-click anywhere at empty document 

area. 

 

Adding to a selection 

 

Add objects to existing selection by holding the SHIFT key while selecting more objects (click-

and-drag to stretch selection frame around them). 

 
Or, you can also add a single equation to the existing selection by pointing the mouse pointer at the 

equation’s moving dot and then by using the SHIFT+mouse-click at the moving dot. 

 

Deselecting a single object 

 

You can deselect single objects from existing selection by holding down the SHIFT key while left-

mouse-clicking at the object you want to deselect. 

 

Select/deselect using the Enter key 

 

By using the Enter key you can select/deselect objects. Just point your mouse at an object and hit 

the Enter key. If the object was not already selected, it will be added to selection (or a new 

selection will be created). If the object was already selected, it will be removed from the selection. 

This is a handy way to select/deselect a single object. 

 

Furthermore, you can select the object that was last created. To make this, take care that the mouse 

is not pointing at any object and then just hit the Enter key – the last created object will become 

selected. This is useful if you need to modify an object that you just created (for example, after 

drawing a line, you want to change its color or thickness). Multiple last-created objects can be 

selected if you press Enter multiple times. 

 

Important note: The Enter key selecting only works when the Typing mode is not active. If the 

Typing mode is active, the Enter key is used for other purposes. 
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Drawing lines and curly brackets 

 

It is possible to draw horizontal/vertical lines and curly braces without need to start the Hand-

drawing mode. The procedure is simple… start as if you are going to select something – by click-

and-drag – but keep your selection frame slim and make sure that it does not select any object. 

 

 
If you keep the selection frame slim and if no object is yet selected within the selection frame, the 

selection frame will show a pale-gray curly bracket (or a line) drawn inside it. If you then hold 

your mouse steady for a fraction of a second (no moving) while still keep holding the mouse button 

down, the pale-gray bracket (or line) will turn darker. 

 

 
Now you can release the mouse button and the curly bracket (or line) will be created 

 

 
 

If you keep the selection frame very slim (few pixels wide only) you are going to create a 

horizontal/vertical line. If you make the selection frame a bit wider (but still slim), you are going to 

create a curly bracket. You can create horizontal or vertical curly brackets. 
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Vertical spacement – making space for more equations 

 

By simple mouse action you can make more space for your equations and drawings. 

 

Point the mouse pointer near the left edge of the document area and hold it steady there for about 

1.5 seconds. The vertical ruler will appear (a yellowish ribbon with a scale). You can then click-

and-drag at the ruler – the horizontal spacing-bar will appear and will move up/down together with 

the mouse pointer. After you release the mouse button, all objects that were initially below the 

spacing-bar position, will be moved down to make more space.   

 

 
 

By pulling in upper direction, you can also decrease the vertical spacing between equations. 

 

If the left gray margin of the document area is visible (a gray zone left of the white ‘paper’ area), 

you can make the procedure without waiting for the ruler to appear – just click at the gray margin 

area and pull down (or up). 
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Grid and Guidelines 
 

 

The grid 
 

To display and use the grid, check the ‘View->Show Grid’ menu option. The grid consists of 

green dots in a square raster. You can choose from three granulations: fine, medium and coarse. To 

change the granulation, use the ‘Options->Grid and guidelines’ menu section.  

 

When grid is in use, you can hold down the ALT key to temporarily disable snapping to the grid. 

 

 

 

Guidelines 
 

The software only supports vertical guidelines. You can define vertical guidelines using the 

horizontal ruler. The ruler is hidden and to make it visible you need to move your mouse pointer 

very near the top edge of the document area and hold it steady there for 1.5 seconds. The ruler (a 

thin yellowish ribbon with a scale) appears. 

 

 
 

The ruler scale is aligned with the grid granulation. By changing the grid granulation, also the ruler 

granulation is changed.  

 

You can left-click on the ruler to quickly define a standard guideline. You can also right-click at 

the ruler for additional options: 
- to insert a standard guideline (a yellow-colored guideline) 

- to insert a text guideline (a green-colored guideline) 

- to insert a text autowrap guideline (a green-colored guideline) 

To delete a guideline, you can click again at its ruler position (marked by an orange mark). Note 

that you can only define 12 guidelines. 

 

Math/text objects will stick to guidelines. Also, if you click a guideline, the new object will start at 

exact horizontal position. The difference between a standard guideline (yellow) and a text 

guideline (green) is in the fact that when you click at a standard guideline you will start a math 

object (as usual, you can convert it to text object by the space bar key), while when you click at a 

text guideline, you will start a text object (and you can convert it to a math object by space bar). 

This way, by defining text guidelines you can simplify your text input. 

 

You can also define a text autowrap guideline. Objects won’t stick to that guideline, but a text box, 

if its text line grows over a text autowrap guideline as you type it, will automatically enfold that 

text line. 
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One proposition of guideline setup in Math-o-mir is given here. Three guidelines are defined, the 

leftmost one is a text guideline, the middle one is a standard guideline and the rightmost one is a 

text autowrap guideline. You can start typing text by clicking at the text guideline. The text will 

automatically wrap when it reaches the text autowrap guideline. To type math, you can just click at 

the standard guideline. 

 

 
 

 

 

Automatic vertical guidelines  

 

In addition to guidelines that you define for the whole document, the Math-o-mir will also display 

localized automatic vertical guidelines when the mouse pointer is nearly left-aligned with nearby 

math/text objects. 

 
 

 

To disable/enable guidelines, use the F12 key. In order to temporarily disable/enable guidelines 

hold down the CTRL key. 
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The Right Mouse Button 
 

The right mouse button, depending on context, can be used for following functionalities: 

 

Click at empty document area (acts similar to the ESC keyboard key) 

- if anything is carried – it will throw it away (mouse arrow changes from black to white) 

- if the Typing mode – it will cancel it (mouse arrow changes from heart-black to white) 

- if the Drawing mode is active – it will cancel it (mouse arrow changes from pen to white) 

- if anything is selected – it will deselect it 

- if context menu is opened – it will close it 

- otherwise – it will redraw the document view 

Click-and-drag - scrolls the main view 

Click-and-drag at selection handles (read squares) - rotates selection (drawings only) 

Click at an object - opens the context menu 

Click at an insertion point - performs the quick multi-touch and opens the context menu 

 
Note that the in some mouse operations (when using certain hand-drawing tools, when stretching selections, when 

editing drawing nodes…) you can hold down the Right mouse button instead of the Shift keyboard key for the same 

effect. Also, you can hold down the right mouse button instead of the Ctrl key when using the mouse wheel for zoom 

in/out. This way you don’t need to reach for the keyboard so often when doing mouse operations. 

 

The Context Menu 

 

The context menu will appear when you right-mouse-click at an object. Displayed context menu 

options will depend on the type of the object you right-clicked at.  

 

You can select a context menu option either by mouse-click or by keyboard (arrow keys and the 

Enter key). You can close the opened context menu by right-mouse click, by pressing the ESC key, 

and of course, by selecting any option from it. 

 

Right-click at a toolbox item opens accelerator context menu where you can define keyboard 

accelerators for given toolbox item. No two toolbox items can share the same accelerator. 
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Right-click at a variable or constant opens variable context menu. You can choose font face, 

italic/bold, and decorations dash/arrow/caret/dots/hacek/tilde. In addition, when appropriate, you 

can add/remove index to the given variable, convert it to measurement unit or convert it to 

function. 

 

 
 

Right-click at whole expression or parentheses opens parentheses context menu. Shape and 

layout of parentheses can be defined. Any particular bracket can be omitted if needed.  

 

 
 

Right-click at ΣΣΣΣ, ΠΠΠΠ or integral sign opens the symbol context menu. You can choose size of the 

symbol and position of limits. 

 
 

Right-click at a drawing object opens the drawing context menu. You can resize/stretch/mirror 

the drawing or rotate it. You can also set the drawing into ‘edit nodes’ mode or otherwise modify 

your drawings. 
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Right-click at a selected object opens the selection context menu. You can group/ungroup the 

selection or align its elements horizontally or vertically. You can align equations ‘on the equal 

sign’ or distribute object one-below-another. You can also resize the whole selection. 

 

 
 

 

Right-click at matrix/table cell(s) or line will also bring up a context menu where cell border 

lines (none, single, double) and cell alignment (left, center right) can be adjusted. 

 

 
 

General stuff about context menus 

 

You can move the context menu around screen by click-and-drag to upper-left corner of the 

context menu window. This is useful if the context menu blocks your view to the document area. 

 

You can hold the SHIFT key while you are mouse-clicking at some options. This way the 

context menu will not close immediately and you will be able to choose several options in a 

single session! 

 

If the symbolic computation feature is enabled, the Math-o-mir will place any calculated solution 

just below the ‘Exit’ option, like in the example below. 
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Using Keyboard in Math-o-mir 

 
If you want to write your math rapidly and efficiently, you should learn the keyboard. At the 

beginning of this manual there are 4
2
/2 examples if you prefer an example-based introduction. 

 

In order to type your equations, you must first start the Typing mode. However, while the Typing 

mode is active, your ability to edit equations using the mouse is reduced. Therefore, while working 

on your document you will frequently want to move in and out of the Typing mode. 

 

 

Starting and ending the Typing mode 

 

Start the Typing mode by left-mouse-click. You can click at: 

 

- empty document area to start typing a new equation or a new text. 

- an insertion point inside any equation to start editing this particular equation  

 

In both cases following things should happen: 
 

-  the mouse pointer will change its shape to heart-shaped black    

-  the blinking cursor will appear at the place you clicked the mouse (the blue or green 

vertical blinking line)    

 
-  the keyboard-control box will appear just below the toolbox, replacing the color-box. 

 

      
 

 

Once the Typing mode is active, any typed letter will appear at the position of the blinking cursor.  

 

 
While the Typing mode is active, there are three other important modes that define how exactly your keyboard will 

behave. I am going to describe them in subsequent chapters: 

 - the Math/Text mode – whether the keyboard will act according to math-typing or to plain-text-typing rules 

 - the Variable mode – whether multi-letter or single-letter variables will be preferred 

 - the chosen Font – determines what font is going to be applied to letters you type 

 

 

 

You can end the Typing mode by: 

- hitting the ESC key 
- or right-mouse-clicking at empty document area 
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The Math/Text mode 

 

When typing, you can always toggle between math and text modes by using, for example, the 

ALT+SpaceBar keystroke. The color of the blinking cursor indicates the current mode: 

 

- blue cursor line – math typing mode 

- green cursor line – text typing mode 

 

In addition, the math/text mode is indicated by the color of the text-control box. 

 

  
One of many alternative ways to toggle math/text mode is to 

mouse-click the ‘Σ’ or ‘T’ sign in the text-control box. 

 

By switching from text to math mode and vice versa, you are able to freely mix math and text as 

you type. Your keyboard will act differently depending on the mode. While math typing rules are 

Math-o-mir specific, the text typing rules are very similar to that of any plain-text editor (MS 

Notepad, for example). 

 

When you start a new entry box, usually the math typing mode will be active. You can toggle it by 

using ALT+SpaceBar keystroke, but even hitting the SpaceBar key alone should suffice when the 

box is still entirely empty. 

 

 

 

The Variable Mode 

 

For efficient math typing, you should choose the Variable Mode wisely. There are two variable 

modes that define how Math-o-mir will handle keyboard input: 

 

- Prefer multi-letter variables - you can easily type multi-letter variables (like: ‘var’, 

‘mass’, ‘anything’, ‘x’...). 
If you type xyz, you will create one single variable called xyz. To begin another variable, either type a 

mathematical operator (‘+’, ‘-‘, ‘/’....) or press the space bar in order to separate variables. 

 

- Prefer single-letter variables - you can easily type single-letter variables (like: ‘X’, ‘a’, 

‘B’, ‘R’...). 
If you type xyz, you will create three separate variables x, y, and z. You can still type multi-letter variables by 

starting them with the apostrophe character: ‘xyz 

This mode is the default one after you install the Math-o-mir on your PC. 
  

 

So, the ‘prefer single-letter variables’ mode relieves you from hitting the spacebar between two 

adjacent variables as the software separates them automatically. But, typing multi-letter variables 

then becomes more annoying. 
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To define the variable mode, use the Options->Keyboard menu.  

 

 
 

 

I recommend: once you decide what variable mode best suits your needs, stick with it. You can 

type all expressions in both modes. The only difference is how handy it is to type them.  

 
Background: in Math-o-mir you should clearly separate math variables. This becomes of practical importance if you 

configured the software to prefer multi-letter variables. When multi-letter variables are preferred, you should take care 

to hit the SpaceBar key between two multiplied variables in case you didn’t use a specific multiplication operator 

between them. Take a look at the following table: 

 
This is understood as one single variable called ‘ab’. No spacebar was hit between ‘a’ and ‘b’. 

 
This is understood as multiplication of variables ‘a’ and ‘b’. The spacebar was hit between ‘a’ and ‘b’. 

 
This is understood as one single variable called ‘sumZ’. No spacebar was hit. 

 
This is understood as multiplication of variables ‘sum’ and ‘Z’. The spacebar was hit between ‘sum’ 

and ‘Z’. 

 
This is understood as multiplication of variables ‘a’ and ‘b’. There was no need to press the space bar, 

because the specific operator (the ‘multiplying dot’) was entered in between. 

 

 

Exception notice: The uppercase Greek delta ‘∆’ symbol will not be automatically separated from 

the following variable even if the ‘prefer single-letter variables’ is used. This way you can type 

variables like ∆x or ∆t easily. 

 

After you defined the variable mode, you can save it permanently by choosing:  

Options->Save settings->Save as default. 

 

 

Handling fonts 

 

Due to peculiarity of math typing, fonts are implemented in a bit different way than in a typical 

word-processing program. 

 

In Math-o-mir environment you can predefine up to nine fonts, and then quickly activate any of 

these nine fonts either by mouse click or by an accelerator keystroke. When you install the 

software you will already find all nine fonts predefined to some defaults, but you can redefine any 

of them as you wish. 

 

Of the nine predefine-able fonts that are at your disposal, eight fonts are limited to uniform casting, 

while one font is capable on mixed casting. Here is the explanation: 
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Uniform fonts – There are 8 uniform fonts that you can predefine and quickly select between 

them. For each uniform font you can predefine: typeface, bold/italic flags, color, decorations… 

When a uniform font is active, all typed letters will be cast in that font. 

 

The Mixed font – This font option enables you to define a different font for every letter separately. 

For every letter you can define typeface, bold/italic flags and decorations. You may, for example, 

define that ‘m’ is always cast as bold, while ‘g’ is always cast as Greek ‘gamma’ symbol… Mixed 

font cannot be used to type plain text (only math).  

 

The first two toolbox options (‘U’ and ‘M’) are used to handle fonts. The active font has a purple 

check mark displayed. To activate a font just click it with the mouse (or use keyboard accelerators: 

by default two accelerators are defined: CTRL+M to activate the mixed font and CTRL+U to 

activate the first of the uniform fonts). 

 

 

Choosing and redefining Uniform fonts 

 

If you point you mouse arrow at the toolbox ‘U’ option and hover it there for a second, a sub-menu 

will open where all eight predefined Uniform fonts are displayed: 

 

 
 

If any of them is the active one, it will have the purple check mark painted. You can click at any to 

activate it (the last active uniform font is also displayed directly in the main toolbox as the ‘U’ 

option – thus, you can quickly switch between the mixed font and the last active uniform font just 

by clicking on the ‘U’ and ‘M’ toolbox options without opening this sub-menu). 

 

In the same sub-menu you can also redefine the actual font details for any of the Uniform fonts. To 

redefine it, move the mouse pointer at any of them and you will see the ‘font…’ option. 
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By clicking at the ‘font…’ option, the menu will open where you can define font details: typeface 

(sans-serif, serif, monospaced or Greek), bold/italic setting, dash/arrow/hat/dots/hacek/tilde 

decorations, font color… 

 
 

 
Advanced: When you will be defining a Uniform font you will notice the “use as singleshot” option. If you enable this 

option for a particular font, this font will behave as follows: Once selected, such singleshot font will remain selected 

for one character only. Thus, it will be applied only to the first next character you type. Once the character is typed, the 

font selection will automatically revert to font that was active just before the singleshot font was activated. This is 

useful if you want just one character to be cast in font different than the others (like making a letter with hat 

decoration), and only makes full sense if you also define a keyboard accelerator to such singleshot fonts so that you 

can activate them quickly as you type… Note that a singleshot font will have a downward arrow displayed in its upper-

right corner (two such examples are visible in pictures above). 

 

 

Redefining the Mixed font 

 

To adjust per-character fonts used for the Mixed font, point your mouse arrow at the toolbox ‘M’ 

option and hover it there for a second. The following menu (table) will open: 

 

 
 

 

By clicking at the desired symbol (letter) from the table, you can define the font that will be used 

when this particular symbol is typed. However, if you want to adjust fonts for all symbols of the 

table at once, just click at the ‘Alter all...’ option and define the desired font. 

 

 

 

Hang on! But I want to write math in italic style, and plain text in normal font style!  

 

It is a common wish to, for example, type math variables in italic font, and plain text in normal 

(upright) font. You can use a simple trick in Math-o-mir to achieve this without need to change the 

font every time you change the math/text mode: 

 

 - set the ‘U’ font to the upright font 

 - set the ‘M’ font to the italic font 

 - make the ‘M’ font active and keep it that way all the time 

 

Every time you switch to plain-text typing mode (by ALT+SpaceBar, for example) the Math-o-mir 

will temporary force-switch to the last used ‘U’ font. It is because the plain text simply cannot be 
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written using the ‘M’ font... As soon as you revert back to the math-typing mode, the ‘M’ font will 

be reactivated. 

 

You can permanently save your font settings by choosing: Options->Save settings->Save as 

default. 

 

Nuts and bolts of math typing 

 

Here I will only briefly mention few general techniques regarding math typing; more details will 

follow in subsequent chapters. Math typing is hard, much harder than plain-text typing, and Math-

o-mir software uses many innovative methods of keyboard usage to make math typing more 

efficient: 

 

- Handy exponent typing – hold down the Alt and type 

- Handy indices (indexes) typing – hold down the Spacebar and type 

- Fingerless shift – hold down a key for about 0.5 seconds to generate Shifted characters 

- Double-stroke Greek symbols – quickly stroke a letter twice to generate a Greek symbol 

- Handy sequences – type sequences like +-, -+, >=, <=, /=, ->… to generate math symbols 

- Post-modifier keystrokes – some keystrokes modify previously entered characters 

- Multi-letter variables – start a multi-letter variable with the apostrophe character 

- Command casting – cast special command by starting a command with the backslash key 

- Toolbox accelerators – define your own keyboard accelerators for quick toolbox access 

- Toggle math/text typing mode – by using eg. Alt+Spacebar or by using the CapsLock key 

- Quick typing – type in a letter or two without even starting the Typing mode 

 

By no means is this a complete list of all Math-o-mir keyboard-handling features. 

 

 

Shortcuts and keystrokes 

 

While the Typing mode is active, you can use following: 
Keyboard arrow 

keys 

Move the cursor around (either inside expression or around the document). 

If you press the shift+up_arrow combination, you can orientate the equation box 

vertically. This only works while the box is still completely empty. 

Backspace Deletes the character just before the cursor. If there is a more complicated expression 

(neither variable nor operator) before the cursor, the backspace key will not delete it 

immediately, but will select it first and delete only after at the subsequent backspace 

key hit. 

DEL Deletes the character just after the cursor. If there is a more complicated expression 

(neither variable nor operator) after the cursor, the DEL key will not delete it 

immediately, but will select it first and delete only after the subsequent DEL key hit. 

ALT+SpaceBar 

SpaceBar+Alt 

Spacebar+Enter 

\\ (two backslashes) 

All these keystrokes toggle between math typing mode and text typing mode. The color 

of the blinking cursor changes accordingly (green for text typing mode, blue for math 

typing mode). In addition you can also use CapsLock (see below). Use the keystroke 

that is easiest to type on your keyboard. 

CapsLock Normally the key is used toggle uppercase/lowercase letters. However, it can be 

configured to toggle math/text typing mode instead. If you do so, you can then use 

Shift+CapsLock or Ctrl+CapsLock to toggle uppercase/lowercase. 

SHIFT+left arrow Selects equation elements to the left.  

SHIFT+right arrow Selects equation elements to the right. 

SHIFT+backspace If an object to the left of the cursor is a variable or a number, it will move the cursor at 
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its end to enable appending… It can also spice separate variables into a multi-letter 

variable. 

^  or  ” Produces exponent. You can then type the exponent. For example, if you type variable 

‘c’, then press the ‘^’ and then ‘b’ it will produce ‘c
b
’. 

ALT+key To quickly produce exponent. For example if you entered variable ‘c’ and then press 

ALT+t, the Math-o-mir will produce c
t
. You can produce quite complex exponents by 

typing while you are holding the ALT key. 

‘_’ (underline) Creates index to variable/function/parentheses positioned just before. For example, if 

you just entered variable ‘R’, pressing the underline and then ‘N’ will produce ‘RN’. 

Note: when you really need to enter the ‘_’ character as a part of a variable, then you 

can do it by typing the underline key twice.  

Note: also jumps into the lower limit box for integral/summation/product symbols. 

SpaceBar+key To quickly produce index. For example if you entered variable ‘c’ and then press 

SpaceBar+t, the Math-o-mir will produce ct. You can produce quite complex indexes 

by typing while you are holding the SpaceBar key. 

CTRL+key Toolbox accelerators – you can define toolbox accelerators yourself. For example 

CTRL+R may generate the square root sign. See the toolbox chapter. 

‘<<’, ‘>>’,’ <=’, 

’>=’, ’+-‘, ’-+’,  

’->’, ‘+>’, ‘:=’, 

‘=:’, ‘=>’, ‘/=’, 

‘~~’,‘-=’, ‘~=’ 

These two-character sequences will produce adequate symbols: 

 

 

‘[)’, ‘(]’, ‘<>’, ‘[>’, 

‘<]’ 

These two-character sequences are converted into brackets (parentheses) 

@ Is converted into the infinite sign (use \@ to produce the @ sign) 

* Is converted to the multiplication operator- the small dot (use \* to produce the * sign) 

// Two slashes – this sequence is converted to proper fraction. Cursor is automatically 

moved to the numerator. 

#  or  ` Hash key or grave accent key – this puts the fraction line under the element that was 

just entered. For example if you entered ‘a’ and then hit the # key, the fraction line will 

be inserted under the ‘a’ variable. This is most useful to enter ‘simple’ fractions that 

only have a single element in the numerator. But if you hit the # or ` key multiple 

times, you will be able to place more than one element into the numerator. 

ALT+arrow key 

Produces arrows. Hit twice to produce double arrow:  

(Note: triple ALT+right_arrow produces the sign – same as the ‘+>’ sequence) 

\{, \[, \(, \< Will produce left-only brackets 

\}, \], \), \> Will produce right-only brackets 

Tab Inserts spacer character. The spacer character is only visible when touched/selected. 

Note that the spacing length can afterwards be modified with mouse. 

SHIFT+Tab Used when building matrices to insert new column (that is, inserts column separators). 

SHIFT+Enter Used when building matrices to make new row (that is, inserts row separator). 

Esc Finishes the Typing mode 

Enter Continues equation editing at next logical position. For example if you are editing 

parentheses content, the ENTER key will continue editing outside parentheses. 

If used at the end of a math line, it will start the new object just below. If used at the 

end of a text line it will wrap the line. 

ALT+Enter Wraps the line (either math line or text line) 

‘++’, ‘- -’, ‘= =’ These double-stroke sequences can be used instead ‘Enter +’, ‘Enter -’, ‘Enter =’ 

sequences. These double-stroke sequences can also wrap the line if used at the end of a 

math line. 

\command By the backslash key you start a command. The command is executed after the space 

bar, the enter key or any operator is entered. Examples: \sqrt, \sum, \kg, \sin, \int... 

SpaceBar Used to separate two multiplied variables when there is no specific operator in 

between. For example ‘a’, space bar, ‘b’ for multiplication of ‘a’ and ‘b’.  

The space bar key can also toggle between math/text entry modes, but only if you hit 

the space bar while the box is still empty. This is faster than using Alt+SpaceBar. 

The space bar key can also execute a command or finish a multi-letter variable entry. 

SpaceBar + arrow Moves (adjusts position of) the equation you are currently editing. 
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keys 

?? Typing two consecutive ‘?’ characters will invoke the context menu with given results 

(if any). You can select the result with keyboard arrow keys and choose it with the 

Enter key.... For example, you can write “2+5=??” (or “2+5??” for short). This will 

open context menu, where result ‘7’ will be displayed. This only works if the symbolic 

calculator is enabled. 

%% Two consecutive ‘%’ characters will turn into the ‘per-mille’ symbol. 

‘ Apostrophe - used to enable writing of multi-letter variables even simple variables are 

preferred. You must start the multi-letter variable with the single quotation mark, and 

end it with space bar, enter or a mathematical operator. 

. Dot (period) – used to convert variable(s) into function or to start a measurement unit. 

Of course, in numbers it is also used as the decimal separator. 

Ins or SpaceBar + . The Insert key or the Spacebar plus comma keystroke pastes from the auto-clipboard. 

 

Math-o-mir will also try to help the following way: 
- if the decimal dot is entered first, and then the number, the zero will be automatically placed in front of the 

decimal dot. Example: you type “.7”, and result will be “0.7”. 

- if two numbers are separated by the space bar, the multiplying dot is automatically inserted in between. 

- if a letter is entered after the number, the Math-o-mir will separate them. For example if you enter “2a”, Math-

o-mir will produce “2 a” (two times ‘a’). 

 

EXAMPLE:  how do you enter 4.75 x 10
7 
?... You must type: 4.75, then you can press the space 

bar (alternatively the ‘*’), then you type 10 and finally you press ALT+7. 

 
 

 

A distinctive detail on keyboard cursor position 

 

In many cases it is good to be familiar with differences between similar positions of the blinking 

cursor line. Look at examples A), B) and C): 

 
 

In the example A) the cursor is placed at the end of the first variable. This will be the position of 

the cursor immediately after you typed a variable. Some keyboard features only work when the 

cursor is in this position (for example, hitting the dot key to convert the variable into a function). 

 

In the example B) the cursor is placed in a new, still entirely empty variable placed between ‘a’ and 

‘b’. You will notice a pale blue hue around the cursor in this case – notifying you that the cursor 

started a fresh, empty variable. This would be the position of the cursor if you hit the spacebar after 

you typed a variable. This is also the position of the cursor after you clicked at an insertion point or 

after you entered a math operator. Some keyboard features only work when the cursor is in this 

position (for example, hitting the comma key to execute the Autocomplete). If you need to move 

the cursor from position B) to position A) you can use the Shift+Backspace keystroke. 

 

In the example C) the cursor is placed at the very beginning of the second variable.  
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Entering multi-letter variables when single-letter ones are preferred 

 

If you configured the Math-o-mir to prefer multi-letter variables then typing multi-letter variables 

is trivial. However, if the software is configured to prefer single-letter variables (default) then to 

enter a multi letter variable, you must start it with the apostrophe (prime) key. 

 

Example: to enter variable named ‘weight’ you should type: ‘ w e i g h t  and then hit the spacebar 

key or any math operator key (+,-,*,/…). 
 

 
 

 

When multi-letter variables are used, it is highly recommended that you always put the multiplying 

dot (*) between two multiplied variables – the ‘invisible times’ should be avoided! 

 

 
This recommendation will also help you with typing because you then don’t need to use the 

SpaceBar to separate variables. 

 

Sometimes, however, you will forget to type the apostrophe key at the beginning of a multi-letter 

variable. Instead of one multi-letter variable you will create several single-letter variables - a tiny 

disaster. Instead of deleting all of them and starting again, you can use Shift+Backspace keystroke 

to splice separate single-letter variables into one multi-letter variable. 

 

Example: You write  x = a * s u m  and you have 
 

 
 

Then you can hit the Shift+Bacspace keystroke (at least) twice and you have 
 

 
 

 

 

Entering Greek symbols (αααα, ββββ, γγγγ, δδδδ …) 

 

Greek symbols can be entered using double-strokes. For example, to enter a lowercase Greek letter 

beta (β), you need to quickly type the ‘b’ letter twice (bb). No more than 750ms must pass between 

two hits of the double-stroke. For uppercase Greek symbols, of course, you need to double-stroke 

uppercase letters (‘WW’ generates ‘Ω’, for example). 

 

Greek symbols can be entered in both, math and text typing modes. In general, you should not 

worry about actual words that contain double-letters because: 

- the transformation into Greek symbols only happens at the beginning of the word 

- if you continue typing past the first two letters, the Greek symbol will revert back to the 

double letter 
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- if you have a rare word consisting only of a single double-letter, you should type those 

letters slowly (or, in math typing mode, you can also start such variable with the 

apostrophe sign to prevent transformation into a Greek symbol). 

 

Some uppercase double-strokes, and the lowercase ‘oo’ double stroke, will not convert into Greek 

symbol because those Greek symbols are visually identical to Latin letters. Consult the following 

table: 

 
Double stroke Result 

RR, NN, ZZ, CC, KK Transform into R, N, Z, C, Q bold serif letters.  

AA, EE, II, TT, OO, UU, MM, 

BB, HH 

Transform into following math symbols: 

 
 

An alternative way to generate a Greek symbol is to cast a command. For example casting the 

\gamma command will generate the γ symbol, while casting the \Gamma command will generate 

the Γ symbol. To learn more about command casting, read the Entering Commands chapter. 

 
Note: double-strokes can be redefined as toolbox accelerators. If you keep a double-letter stroke defined as a toolbox 

accelerator, you will not be able to use that particular double-stroke to generate the Greek symbol. Instead, you will 

have to use a command to enter that Greek symbol… Still, it may make sense to define some double-stroke toolbox 

accelerators because you might rarely need some of Greek symbols. 

 
Note: there is a special handling when you enter Greek symbols into indices (indexes) using the double-stroke method. 

When typing indices you can use the third stroke to revert back to Lattin letters. For example to type ‘Vcc’ you might 

type: V <spacebar held> c c c <spacebar released> 

 

 

Entering indexes 

 

There are two ways to enter indexes (indices): 

- using the SpaceBar key 

- using the underline ‘_’ key 

 
Note: It is only possible to add indexes to variables, parentheses, functions, and differentials. 

 

 

Generating indexes using the SpaceBar key 

 

This is the handier method to type simple indexes. This can also be the handier method to type 

indexes that contain simple math operators (‘+’, ‘-‘, ‘,’) if you keep the ‘Options->Keyboard->Use 

complex indexes’ option unchecked. 

 

Usage: imediately after you entered a variable, press and hold the SpaceBar key. Any further 

typing, while the SpaceBar is held, will be entered into the variable index. After you release the 

SpaceBar, the cursor automatically resumes at the main equation line. 

 

Example:  Typing:  x <spacebar held> 1 , 2 <spacebar released> y    generates: 
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Note: you might also have difficulties when using the SpaceBar method to type uppercase letters into index. This is 

because you will need to hold both, SpaceBar and Shift keys, while you are typing the index. To avoid holding the 

Shift key you can use the Fingerless Shift feature: hold down a key for about 0.5 seconds until the shifted version of 

the character is produced. For example if you want to produce ‘iR’, you can type: i <spacebar held> <the‘r’ key held 

for about 0.5 sec> <’r’ and spacebar released> 

 

Note: the index you are entering while holding the SpaceBar key is displayed with a pale-blue background.  

 

 

Generating indexes using the underline key 

 

This is a more general method. It too is quite handy if the underline ‘_’ key can be easily reached 

on your keyboard. 

 

Usage: immediately after you entered the variable, hit the underline ‘_’ key. The variable index 

will be crated and the cursor will be placed inside so that you can type the index. After you 

finished with it, you can hit the Enter key (or any math operator) to resume typing on the main 

equation line. 

 

Example:  Typing:     x _ 1 <Enter> y     generates: 

 

 
 

 
Important Note: If you use the underline key to enter indexes, any attempt to enter some math operator (like ‘+’, ‘-‘, 

‘/’…) into index will exit the index entry and the operator will be force-placed into the main equation line. This is 

handy when you type simple indexes because in many cases you don’t need then to use the Enter key to finish the 

index entry. But it might trouble you if you need to enter a complex index that must contain a mathematical operator…  

 

There are three solutions: 

1. Immediately after you typed the mathematical operator (it will be placed into the main line) hit the underline ‘_’ 

key again and the operator, together with your cursor, will be moved to the index again…  

   Example: typing:    x _ 1 + _ 2 <Enter> y     generates: 

 

 
2. Check the ‘Options->Keyboard->Use complex indexes’ option and then you will be allowed to freely enter math 

operators into indexes, but then you will always have to finish the index entry by hitting the Enter key.  

3. Use the handy Spacebar method, as previously explained. 

 

 

 

Entering exponents 

 

There are two ways to enter exponents: 

- using the Alt key  

- using the ^ key, or the “ key  

 

Entering exponents using the Alt key 

 

This is the handier method to enter simple exponents (for instance, it is ideal to enter integer 

exponents).  
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Usage: After you entered an object, press and hold the Alt key. Any further typing, while the Alt 

key is held, will be added to exponent. After you release the Alt key, the cursor returns back to the 

main equation line. 

 

Example:   Typing:    x <Alt held> - 2 + a <Alt released> y    generates: 

 

 
 

 

Typing very complex indexes (those containing functions, other exponents, fractions or special 

math symbols) is usually better done, and sometimes only possible using the the ^ key (or the “ 

key) method. 

 

However, you might choose to start entering an exponent using ALT key method, and then, in the 

middle of exponent entry, switch the method. This can be done by releasing the Alt key after you 

entered an operator (‘+’, ‘-‘, ‘/’,…). The Math-o-mir will conclude that the exponent entry is not 

yet finished and will leave the cursor inside the exponent box so that you can finish typing it. 

 

Example:   Typing     x <Alt held> n + <Alt released> 2 K <Alt+2> <Enter> y   generates: 

 

 
 

 
Note: you might have difficulties using ALT-key method to type uppercase letters into exponent. This is because you 

will need to hold both, the Alt key and the Shift key, while you are typing. To avoid holding the Shift key you can use 

the Fingerless Shift feature: hold down a key for about 0.5 seconds until the shifted version of the character is 

produced. For example if you want to produce ‘x
N
’, you can type: x <ALT held> <the‘n’ key held for about 0.5 sec> 

<’n’ and ALT released> 

 

Starting an exponent with ‘f’, ‘e’ or ‘v’ letters might also be problematic because Alt+f, Alt+e and Alt+v are used to 

access menus. If you don’t intend to access menu using these shortcuts then, please, uncheck the following option: 

“Options->Keyboard->Use Alt+F,E,V for menu access”. 

 

Note: when you type an exponent with the Alt key, you will not be able to enter the = (equal) sign into the exponent. 

All = signs will be replaced with the + (plus) sign. This is to make typing the ‘plus’ easier on some keyboards, as there 

will be no need to hold down the Shift key nor to wait for 0.5 seconds to trigger the Fingerless Shift feature. 

 

Tip: It is sometimes easier to enter simple negative exponents the following way (the minus is typed prior the Alt key): 

 

     x - <Alt held> 3 <Alt released>     

 
 

 

Note: the exponent you are entering is displayed with a pale-blue background while the ALT key is held down. 

 

 

Entering exponents using the ^ key (or the “ key) 

 

This is the more general method. The reason why two different keys (the ‘hat’ key and the 

quotation-mark key) are provided for the same purpose is because on some keyboards, the ^ key 

acts as a ‘dead key’ and is therefore difficult to use. 
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Usage: after you entered an object, hit the ^ key (or the “ key). The exponent will be created and 

the cursor will be placed inside so that you can type the exponent. After you finished with it, you 

can hit the Enter key to resume typing on the main equation line. 

 

Example:    Typing   x “ 2 a <Enter> y   generates: 

 

 
 

 

 

Entering exponents of base ‘e’ 

 

There is a simple way to enter exponents of base e. Type ‘e’ and then immediately hit the dot 

(period) key. The exponent is created and you can type into it. The ‘e’ symbol is cast into serif, 

italic font. 

 

 

 

 

Entering fractions  

 

You can insert a fraction by using the double slash ‘//’. The double-slash sequence will generate 

the fraction line and the cursor will automatically move into the numerator. 

 

 
 

You can hit the Enter key to move the cursor into the denominator once you are finished with the 

numerator. 

 

However, for many people it is not natural to type simple fractions starting from the fraction line. 

Many are accustomed to write the numerator first, and then the fraction line. In Math-o-mir it is 

also possible to write fractions this way by using the # key (or the grave accent ` key).  

 

Example:  Typing:     a + b c # d    generates: 

 
 

 
It is even possible to type the # key (or the ` key) several times in the row. For every hit, a single element left of the 

fraction sign will be sucked into the numerator. Thus, a + b c # # d   generates: 

 

 
 

If the # key (or ` key) was hit at the beginning of an expression box, or just after a mathematical operator, the empty 

fraction will be generated – exactly as if you used the double-slash ‘//’. 
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Entering commands  

 

 

When in the Typing mode, you can enter some commands. Most of these commands will instruct 

Math-o-mir to insert a specific mathematical symbol. 

 

All commands start with the backslash character ‘\’. 

 

The command is executed when the SpaceBar key, Enter key or any other keystroke (like ‘+’, ‘-‘, 

‘*’, ‘/’, ‘\’...) that obviously cannot be a part of the command, is entered. For example, if you type 

in the “\frac” command, and then you press the space bar, the true fraction sign will be inserted and 

the cursor will automatically move to its numerator. 

 

Following commands are possible: 

 
- square root and root: \sqrt, \root 

- logic operators: \and, \or, \nand, \nor, \xor, \not 

- summation, product, binom: \sum, \prod, \binom 

- other operators: \mod, \pm, \mp 

- proper fraction: \frac  (the faster way is to type double-slash ‘//’) 

- integrals: \int, \iint, \iiint, \oint, \oiint, \oiiint 

- case condition: \case 

- vertical orientation: \vert 

- Greek symbols: \alpha…\omega, \Alpha… \Omega, \ep, \varpi 

- differential: \d, \dx, \dy, \dz, \par, \partial, \dd, \ddx, \ddy, \ddz, \ddt 

- functions:  \funcfunc_name  (example: \funcint) 

- unit of measurements: \unitunit_name  (example: \unitpeso) 

- font size: \big, \bbig, \small 

- font color: \black, \red, \green, \blue, \gray 

- headline: \h1, \h2, h3 

- link and label: \link, \label 

- other LaTeX compatible commands: \angle, \approx, \aleph, \emptyset, \infty, \ast, \neq, \nabla, 

\times, \cdot, \bullet, \div, \oplus, \otimes, \cup, \cap, \sim, \cong, \equiv, \doteq, \parallel, \perp, 

\propto, \subset, \supset, \subseteq, \supseteq, \to, \space, \varphi, \leq, \geq, \elm (equivalent to \in 

in LaTeX), \owns, \notin, \exists, \forall, \circ, \mapsto, \therefore, \because, \square, \triangle. 

 

 

Entering functions  

 

There are two distinct methods to enter a function: 

- by conversion (using the dot/period key) 

- by command casting 

 

Conversion method 

 

This is usually the handier method. 

 

The idea is to type the function name as when you are typing variables and then to hit the dot 

(period) key to convert variable(s) into the function. For example, if you type  s i n .  the last three 

variables (‘s’, ‘i’ and ‘n’) get converted into the sin function. 
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Advanced: The dot-key modifier always converts the last entered variable into a function. But if the software is 

configured to prefer single-letter variables it will also analyze several last variables and check if combined they make a 

common function name. If not, only the last variable will be converted into a function… Following function names are 

recognized: arcsin, arccos, arctan, arccot, arctg, arcsec, arccsc, cosec, csc, sec, sin, cos, tan, log, ln, par, tg, cot, lim, 

arch, arsh, arth, arcoth, arsech, arcsch, sech, csch, sh, ch, th, coth, Re, Im, max, min, exp, arg, Res.   

 

To create a non-recognized multi-letter function enter the function name starting with the apostrophe sign (like: 

‘myfunc) and then hit the dot conversion key. (Or just use the command casting method instead.) 

 

Note that single-letter functions are immediately created with parentheses: f . converts to f( ). If 

you want a different kind of parentheses you should then immediately hit either the ‘[‘ or the ‘{‘ 

key. Multi-letter functions are created without parentheses: s i n . converts to sin, but you can then 

immediately hit either ‘(‘ or ‘[‘ or ‘{‘ keys to add the parentheses. 

 

There are special handlings for some conversions: e . converts to exponential function; d . converts 

to differential; p a r . converts to partial differential; l i m . converts to limes; s u m . converts to 

summation sign; i n t . converts to integral sign. (Note: the summation and the integral sign will be 

generated without upper and lower limits, but you can generate them if you immediately hit the 

underline key. Example: i n t . _ ) 

 

You can also create ‘derived’ version of function by typing, for example: f ’ . or f ’ ’ . In addition 

you can create Greek-symbol-named function by typing, for example: bb . or GG . 

 

Finally, you can create indexed functions by converting an indexed variable. For example, you can 

type f _ 1 . to create f1() function. Another way to create the same function would be by typing: f 

<space held> 1 <space released> . 

 
But you can also add an index to an already created function: create the function and when the cursor is in the first 

place of the function argument either hit the underline key or type with the spacebar held down. The similar way can 

generate exponents to functions: create the function and when the cursor is in the first place of the function argument 

either hit the ^ key (or “ key) or type with the ALT key held down. 

 

 

Command casting method 

 

This is the more general method, and can be almost equally handy on keyboards where the 

backslash key ‘\’ is easily reachable. 

 

To cast the function, just type the following command: \function_name (where the function_name 

is the name of function you want to create). Then either hit the spacebar key, enter key, bracket key 

or even an math operator (like ‘+’, ‘-‘, ‘*’, ‘/’) to create the function.  

 

 
 

If you used the ‘(‘ key to create the function, it will be created with parentheses around its 

argument. However, even if you created your function without parentheses, you can still add the 

parentheses by stroking the ‘(‘ key right after the function is created – this is shown in the example 

below. (Note: single-letter functions are always created with parentheses.) 
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Example: - type: \sin 

 
- press the space bar key (or the Enter key) to execute the command. The function sin  

  is created and the cursor is moved into its argument 

 
- if we want, we can hit the ‘(‘ key to add parentheses around function argument 

 
 

 

Not all function names can be used freely! Function with names that are already reserved for 

commands (\sqrt, \nand, \mod, \frac, \sum...) and those already reserved for units of measurements 

(\kg, \oz, \Nm, \mps...) cannot be created this way. But when you need to enter, for example, the 

function called sum, you can use the following command \funcsum.  

In some cases, even reserved names can be used if you execute the command with the ‘(‘ key. For 

example, command ‘\g’ when executed with the space bar will create ‘gram’ unit, but when 

executed with the ‘(‘ key will create function ‘g()’.  

 

Moreover, you can cast commands in form: \funcaplha ... \funcomega (or \funcAlpha … 

\funcOmega) to create Greek-symbol functions. For derivatives, you can also use for example 

\funsum’ or \funcGamma’’ commands.  

 
Example: - we type the following command \funcGamma’’ 

- and then we hit ‘[‘ key to execute the function 

- function is created, and the cursor is moved into its argument 

 
 

 
Note:  in Math-o-mir, functions are displayed in a bit greenish color and, by default, in upright serif font. This is to 

distinguish them from variables more easily. 

 

Functions without arguments: Sometimes, we need to enter a function without argument box. This can be done 

easily by hitting the enter key while the function argument box is still entirely empty. For example, we can type: h . 

<enter> = f . <enter> OO g . <enter> 

 
(The ‘OO’ sequence must be typed rapidly.) Note that if you position the cursor just after such ‘bare’ function and you 

hit the ‘(‘ key, you will again create the argument box to this function. 

 

 

Entering units of measurement 

 

To enter a measurement unit, you should start with the dot (period) key.  

 

For example, if you type:  . P a = . N / m <Alt held> 2 <Alt released> you should obtain: 

 

 
 

 

Units of measurement are displayed in a bit pale color compared to other math elements. In 

addition, measurement units are typesetted in a more condensed form (less space between them).  
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In rare cases you might need to enter a measurement unit after you typed a variable. In this case 

you have to hit the SpaceBar before you type the dot key. But most often, you need to type a 

measurement unit behind a number in which case the SpaceBar is not needed. 

 

For example:   2 . 7 5 . m m = X <SpaceBar> . u m 

 

 
Here we see that the SpaceBar is only needed if we are entering a measurement unit behind a variable (if we don’t hit 

the SpaceBar after the variable, the dot key would transform the variable into a function). 

 

In the above example, you can see that the ‘u’ letter is transformed into Greek ‘µ’ letter. This way 

you can type the ‘micro’ quantifier in front of many units known to Math-o-mir. Here is a list of 

units known to Math-o-mir. 

 

SI units and derived SI units  

 
- g (gram), m (meter), s (second), mol (mol),cd (candela), rad (radian), sr (steradian), A (ampere), Hz (hertz), V 

(volt), T (tesla), Wb (webber), F (faraday), C (coloumb), ohm (ohm), S (siemens), H (henry), lm (lumen), lx 

(lux), Bq (bequerel), Gy (gray), Sv (sievert), kat (katal), J (joul), N (newton), W (watt), K (kelvin), Pa 

(pascal), t (tonne), dB (decibel) 

 

Other units  

 
- eV (electron-volt), deg (degree of arc), ’ (minute of arc), ’’ (second of arc), L (liter), degC (degree Celsius), lb 

(pound), lbm (pound), oz (ounce), ton (ton), mi (mile), nmi (nautical mile), ft (foot), in (inch), yd (yard), h 

(hour), mn (minute), day (day), yr (year), pt (pint), qt (quart), gal (gallon), bbl (barrel), ppm (part-per-million) 

 

Many of above-mentioned units can be combined with prefixes: p (pico), n (nano), u (micro), m 

(milli), c (centi), d (deci), h (hecto), k (kilo), M (mega), G (giga), T (tera)… The above-mentioned 

known units can also be inserted by casting a command. For example to insert Ω, you can cast 

\ohm command. This command-casting method is provided mostly for legacy reasons. 

 

Special cases and tips: 
- to type minute-of-arc or second-of-arc units behind a number you don’t need to start with the dot key. Instead 

of 14.’ you can just type 14’ 

- to type degree-of-arc unit behind a number, you don’t need to use .deg. Instead you can use triple apostrophe: 

14.3’’’ 

- to type degree-of-Celsius behind a number, you don’t need to use .degC. Instead you can use ‘C. For example 

30’C (or, if you wish, 30’’’C) 

- the .ohm will be converted into the ΩΩΩΩ sign. For example: .uohm is converted to µΩµΩµΩµΩ 

- the .Nm is converted to Newton-metre compound unit (that is, you don’t need to type the spacebar between N 

and m as it will be inserted automatically). The same with .Ns 

 

Once you entered a unit of measurement, subsequent variables you are going to type will also be 

converted to units. This makes typing of compound units much easier. For example, we can type:   

. k g <SpaceBar> m / s <ALT+2>  to produce: 

 
As you can see, we didn’t have to use .s and .m to enter meters and seconds in the above 

compound unit expression. But notice that we had to hit the SpaceBar between ‘kg’ and ‘m’ to 

separate them. 
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There are two additional ways to insert a unit. The first is to cast \unitname command. For 

example, use command \unitpesos to enter a unit called pesos. The second is to convert any 

variable into a unit. For example you can write variable called ‘pesos’ and then right mouse click 

on this variable and choose “Convert to unit’ button.   

 

 

Entering “decorated” variables  

 

You can decorate a variable with dash, hat, arrow, dot, star… Immediately after you typed a 

variable, use the following decoration methods: 

 
Key sequence Decoration example 

‘ (apostrophe) 
 

‘‘ (two apostrophes) 
 

^^ (two hats)   
 

^* (hat, then star)  
 

Alt+, (Alt+comma) 
 

Alt+,, (Alt+comma; twice) 
 

Alt+. (Alt+period) 
 

Alt+.. (Alt+period, twice) 
 

Alt+... (Alt+period, three times) 
 

 

An alternative way to add a decoration to a variable is to mouse-click at the desired decoration 

inside the text-control box. 

 
 

Note: you can also use singleshot fonts to generate variables with decorations, but in this case a 

singleshot font must be activated (by a keystroke accelerator, preferably) before you type the 

variable. 

 

 

Typing multi-line equations 

 

Many times we want to write a single equation with multiple lines. An alternative to this would be 

writing each line as a separate object (separate equation), but this might not look nice or might not 

come handy… In Math-o-mir you can wrap the math line by using Alt+Enter keystroke, and this is 

how you can create multi-line equations. 

 

In the following example we have some equation 

 

 
 

Then we used Alt+Enter to wrap the line 
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The cursor is now moved in the new line, but still inside the same equation object (this is very 

different than if the Enter key alone was used in which case the new object would be created). Now 

we can, say, hit the TAB key to insert a spacer character and then continue to type like follows: 

 

 
 

The problem is that the spacer character is too short and the two equal signs are not aligned very 

well. We could add another spacer character, or we can adjust the length of that spacer character – 

we can adjust its length using our mouse: point the mouse at the spacer character head (it will 

become visible when we point the mouse pointer above it in order to ‘touch’ it) and then click-and-

drag to adjust its length. 

 
 

If we hit the Alt+Enter again to make another line wrap inside that equation object, and if then we 

use the TAB key to generate the spacer, the spacer will be automatically generated with the equal 

length as the spacer above it (the one whose length we just adjusted). 

 

 

Sometimes, however, faster and easier methods can be used to achieve the same. Again we will 

begin from the same equation and then we will hit the Alt+Enter key. 

 

 
 

If we now hit the ‘equal’ key twice (‘= =’), the result will be that the spacer character will be 

automatically added, and its length will be adjusted so that the equality operator will be aligned 

(more or less) with the equality operator of the first line. 

 

 
 

Whenever you use the double-equal keystroke at the beginning of the second (or any non-first) 

line, thespacer character will be added so that the equality operator will be aligned. In the 

following example the Alt+Enter was used at the end of every line and then the double-equal 

keystroke is used to align the equality operator: 
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Note: If you really don’t care if every line makes a separate object, you can use the Enter key alone 

(instead of the Alt+Enter) at the end of each line. Even in this case the double-equal keystroke will 

work and will align the equality operator! 

 

 

But if you want (or if you don’t care) to also have the equality operator at the end of each line (as 

well as at the beginning of it), you can just use the double-equal keystroke at the end of every line. 

This will do both, wrap the line and make the alignment. 

 
 

In the above example the Alt+Enter key was never used. Only the double-equal keystroke was used 

at the end of the first two lines. 

 

 

In fact, you can use the double-plus (‘++’) or the double-minus (‘- -‘) keystrokes in a similar 

manner to wrap a line. In the example below, the ++ sequence is used at the end of the first line 

 

 
 

 

 

Writing plain text in Math-o-mir 

 

Normally, when you start the Typing mode, the Math-o-mir will assume that you want to write 

some math and therefore the math-typing mode will be activated. However, many times you want 

to write just a plain text. So if you really want to start a plain-text box you can: 

 
- mouse-click at document area to start the Typing mode and then use ALT+SpaceBar to switch into text-typing 

mode. Alternatives to the Alt+Spacebar are the Spacebar+Enter or the double-backslash (hit the backslash 

key twice) to toggle between math and text mode. These alternatives might come easier on some keyboards. 

- or mouse-click at the document area to start the Typing mode and then hit the SpaceBar while the box is still 

entirely empty. Spacebar (even without ALT) will toggle the math/text mode if the box is entirely empty 

- or mouse-click at the document area to start the Typing mode and then mouse-click at the ‘Sigma’ sign in the 

text control box to switch into the text-typing mode. 

- or double-mouse-click at the document area. This starts the Typing mode with the text-typing already 

activated. 

- or just mouse-click at a text guideline. This starts the Typing mode with the text-typing already activated  

 

Instead of using the Alt+SpaceBar to toggle the typing mode, you can configure Math-o-mir to use 

the very handy CapsLock key for the same purpose. To make this possible, check the following 

menu option: Options->Keyboard->Use CapsLock to toggle typing mode. But if you use this 

option, you will not be able to use the CapsLock to toggle between uppercase/lowercase letters any 

more. Instead, you must then use either Shift+CapsLock or Ctrl+CapsLock to toggle the 

uppercase/lowercase letters. 
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When the text typing mode is active, the keyboard cursor is displayed in green color instead of the 

standard blue. Also the text-control box is displayed in green color. 

 

 
 

As you type the plain text, a sign can appear below the blinking cursor. This sign tells about how 

the Enter key is going to be interpreted. If the sign is present, the Enter key will wrap the text line. 

If the sign is not present, the Enter key will start the new object. 

 

 
Sure, you can always wrap the line by using ALT+Enter, even if the sign is not present. On the 

other hand, if the sign is present but you need to start the new object, then you should hit the Enter 

key twice. 

 

When the text typing mode is active, you can paste plain text from windows clipboard. Use the 

CTRL+V keystroke (or use menu: Edit->Paste).  

 

You can easily mix formulas and plain text – read about it in the next chapter. 

 
Note that: a word of plain text behaves different than a math variable. If you point the mouse pointer on it, it will not 

highlight – you cannot touch a word of plain text by simple mouse pointing. Instead, the mouse pointer is only able to 

touch insertion points between letters. You can, however, touch (highlight, select) a plain text by holding down the 

shift key while you are dragging your mouse pointer (i.e. by using the multi-touch action). 

 

 

 

 

 

Mixing math formulas and plain text 

 

When typing, you can easily switch from math-typing mode to text-typing mode and vice versa, 

using the ALT+SpaceBar keystroke. (Alternatively, you can hit the Spacebar+Enter or use 

double-backslash keystroke. You can even use the CapsLock key if you configured the Math-o-

mir to use the CapsLock key as a typing mode toggle button.) 

 

 

Example:  - you can start typing some math (blue cursor) 

 

 
 

 - then you switch into text-typing mode by using ALT+SpaceBar (the cursor 

       changes to green) 

 

 
 

 - now you type your text 
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 - switch back to math-typing by ALT+SpaceBar (the cursor changes to blue) 

 

 
 

 - and continue typing some more math 

 

 
 

 

In addition, of course, you can use the mouse ‘pick up – carry – place down’ action to place math-

formulas into text boxes and vice versa. 

 

Note to Linux users: using ALT+SpaceBar may not be possible if it activates a system menu. In 

this case use Spacebar+ALT or SpaceBar+Enter or double-backslash to switch the typing mode. 
 

 

 

Editing with keyboard – cut, copy, paste 

 

While the Typing mode is active, you can select a part (or whole) of your equation, cut/copy it and 

then paste it to another place using keyboard only. No need to reach for the mouse. You can also 

modify your selections in various ways (change fonts, put parentheses around…). 

 

To select equation elements, use right or left keyboard arrow keys while the SHIFT key is held 

down. Selected elements will be displayed in blue color. Once you have them selected, you can: 

 
- delete them by DEL or Backspace key 

- cut or copy them by using CTRL+X or CTRL+C keystrokes (later use CTRL+V to paste) 

- use any of ‘implanting keys’ to make keyboard implanting actions (see next chapter) 

- additionally modify the selection by calling up the context menu (with the Enter key) 

 

 

Example: 

- you typed the following expression:   

 
 

- then you realized that you should multiply the ‘b+c’ by 2. To make necessary 

 corrections, you press the SHIFT key, and then hit the left arrow key three times 

  before you release the SHIFT. This way, you selected the ‘b+c’ part of the 

  equation (Note that the cursor actually did not change its position). 

 

 
 

- using the CTRL+X you cut the selection 
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- now you type the ‘2’ and then the ‘(‘ key 

 

 
 

- and finally, you use the CTRL+V to paste the ‘b+c’ inside parentheses 

 

 
 

 

Note that you can also use SHIFT+Home and SHIFT+End keystrokes to select everything from the 

cursor position to the beginning or the end of the expression or line. 

 

 

 

Using the Auto-clipboard 

 

The Auto-clipboard is a simple clipboard that is separate from the standard clipboard (the standard 

clipboard is the one that is used with Ctrl+X,C,V keystrokes). You cannot specifically tell the 

Math-o-mir to store something into the Auto-clipboard. Instead, the Math-o-mir stores objects into 

this clipboard automatically whenever you place-down something into your equations. 

 

To paste from the Auto-clipboard you can hit the Insert key or you can hit the SpaceBar+dot 

keystroke (the Spacebar+dot being handier on many keyboards). 

 

For example, if you recently reached for the toolbox to insert some rare math element into your 

equation, you can insert the same element again by hitting the Insert or the Spacebar+dot. It can 

also be useful to reuse computation results as in the following example. 

 
A simple computation is made (first the 13 / 7 is typed, then the ?? keystroke is used to start the calculator) 

 

 
 

The Enter key places the result into the equation (it also gets automatically copied into the Auto-clipboard) 

 

 
 

The Enter key is hit again to start the new line, and then the Ins key was hit to paste the 1.86 from the Auto-clipboard 

 

 
 

 

 

Calling the context menu with keyboard 

 

As already mentioned, you can call the context menu by striking the Enter key once you selected a 

part of your expression. Then, from the context menu you can select (using keyboard arrow keys) 

your option and hit Enter key to execute it. 
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For example, you wrote the ‘a+b’ equation, and now you want to add a hat to the ‘b’ variable  

 

 
 

1. Press and hold the SHIFT and hit the left arrow key once to select the ‘b’ 
 

 
 

2. Hit the enter key to open the context menu 
 

 
 

3. Using keyboard arrow keys (or mouse) select the ‘a with hat’ option and hit the Enter key. The result is 

below: 

 
 

Note: There are, in fact, more practical ways to add hats… after you typed a+b, just hit the ‘^’ key twice to add the hat 

over ‘b’. 

 

 

 

Keyboard Implanting 

 

This mysterious feature is a keyboard equivalent to mouse-made implanting. With implanting you 

can put objects ‘around’ already existing objects.  

 

It is very straightforward to use keyboard implanting: 

- using keyboard (SHIFT+left/right arrow key), select part of the expression 

- hit any one of ‘implanting keys’ 

 

The recognized ‘implanting keys’ are: 
- ‘(‘, ‘[‘ or ‘{‘ key – to put selected objects into parentheses 
- ‘/’, ‘#’ or ‘`’ key – to put a fraction line below selected objects 
- ‘0’…’9’ number keys – to put selected objects under exponent 

-  ‘\’ key – to put selected objects into a function (you will then need to type in the correct function name and 

then either hit the spacebar or the ‘(‘ key). 

- ‘C’ key – puts the constraint (restriction) line after selected objects 
- ‘R’ and ‘G’ keys – sets objects to red or green color 
- ‘B’ and ‘I’ keys – sets object text to bold or italic style 
- ‘U’, ‘O’, and ‘S’ keys – draws underline, overline or strikeout line  
 

Note that the Ctrl+X, Ctrl+C, Del and Backspace will also work as expected with keyboard selections. The Enter key 

will call the context menu over selected objects as it is explained in previous chapter. 
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Example:  

- let’s say that you  already wrote the ‘2a+b’ expression, and then 

   realized that you had to put parentheses around ‘a+b’ part: 
 

 
 

- to select the ‘a+b’ part, you will press and hold the SHIFT key and  

  hit the left arrow key three times (each hit to the left arrow will select one  

  additional element): 

 
 
 

  - now, as the wanted part is selected, you simply hit the ‘(‘ key. This  

  will put parentheses around objects that you selected. 
 

 
 

 

 

What is the Enter key used for? 

 

In Math-o-mir, the functionality of the Enter key depends on the context. Basically, the Enter key 

is used to move the blinking cursor to the next logical spot inside the equation. For example, you 

may be typing the numerator and then hit the enter key – the cursor is moved into the denominator. 

 
However, if the denominator was already defined, the cursor will be moved just after the fraction 

element: 

 
 

In many cases, if the element you are editing contains an empty box, the Enter key will jump into 

it. If there are no empty boxes, the Enter key will jump behind that element. This however is not a 

strict rule. 

 

If the cursor is at the main equation line, the Enter key will jump out of the equation and will create 

the new equation box just below the one you were editing. 
 

 
 

However, when mostly plain text is entered in a box, a small, pale sign may be displayed below the 

blinking cursor. This tells that the Enter key will not create the new box, but will instead only wrap 

the line (btw, you can force line wrapping any time by using ALT+Enter). 
 

 
 

There are other functions of the Enter key as well. When you type in a command, you can execute 

it with the Enter key (or with the SpaceBar). When you select anything using the keyboard, you 
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can hit the Enter key to open the context menu. Finally, using the Shift+Enter keystroke, you can 

add a new matrix/table row. 

 

Instead of the Enter key, you can sometimes use the ++ (plus-plus) or the - - (minus-minus) or the 

= = (equal-equal) keystroke sequences. The plus-plus sequence is going to be translated as if you 

typed the Enter key, then the plus key. The minus-minus sequence is going to be translated as if 

you typed the Enter key, then the minus key. For example: a ^ 3 + + 1 will generate:  

 

 
 

 

 

What is the Dot (period) key used for? 

 

Depending on context, the dot (period) key may be used: 

 

- as a decimal separator (decimal point) – when typed as a part of a number 

- to convert a variable into a function – when typed immediately after a variable 

- to start typing a measurement unit – when typed immediately before unit 

 

 

The Autocomplete 

 

As you type a math formula, the Math-o-mir constantly examines nearby equations and checks if 

there is any expression there that would ‘structurally match the position of your entry’. If such 

expression is found, it is marked with the yellow-orange color. 

 

When such marking happens, you can use the comma key to execute the Autocomplete. 

 

Example: Suppose you are writing the second equation, and as you moved your cursor into the 

fraction denominator, the Math-o-mir marked the denominator in the first equation. 

 

 
 

Now you can simply hit the comma key to execute the Autocomplete, and the marked expression 

will be copied to your cursor position.  

 

In some cases, there will be more than one possible solution for the Autocomplete. The Math-o-mir 

will mark one of them, but will re-evaluate as you continue to type. Once the Math-o-mir marks 

the right expression, you can hit the comma key to execute the Autocomplete. 

 

Unfortunately, the comma is also used as a list separator and therefore in order to execute the 

Autocomplete just after you typed a variable (or a number) you may need to hit the comma key 
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twice. (The first comma is interpreted as the list separator, and only the second comma key hit will 

execute the Autocomplete.) 

 

Example: As you were typing a formula, you entered the new fraction sign and the Math-o-mir 

childishly marked the numerator of the some existing fraction sign 

 

 
 

But we want the x+1 numerator from the very first fractions sign, therefore we type ‘x’: 

 

 

 
 

The Math-o-mir now marked the first numerator. But when we type the comma key, nothing much 

happens – the Autocomplete is not executed because the comma is interpreted as a list separator. 
 

 
 

But if we hit the comma key once more, the Autocomplete will be executed. 
 

 
 

 

 

Advanced keyboard examples 

 

Some more advanced examples of keyboard usage are presented here. 

 

Example 1: limes 

 
1. Type lim and hit the dot key to convert what you typed into the limes. The cursor is automatically placed into 

the box below the limes. (An alternative way to enter a limes is to type the \lim command and use the 

underline ‘_’ key to create the limes. This way the cursor will be placed directly into the box below the limes. 

This would not be the case if we created the limes with the SpaceBar or the Enter key after the \lim.)  

2. Type  n->0  (note that the ‘->’ sequence will be converted to the right arrow. Alternatively, you could use 

ALT+right_cursor_key to create the arrow. Or you could even use \to command to create it). 

3. Hit the Enter key (or the up_cursor_key) to move to the limes function argument box 

4. Type the slash key twice (‘//’) to create the fraction. (Alternatively, you can cast the \frac command). 

5. Type ‘1’ then hit the Enter (cursor is moved to the denominator). Type ‘n’ and hit the Enter key again (cursor 

is moved to the limes function argument baseline). Finally, if you want exit out of the limes, you could hit the 

Enter key again (or hit the right_cursor_key). 

 
Note: It is possible to make steps 4 and 5 the following way: type 1, type #, type n, hit Enter, finally hit Enter again to 

exit the limes. 
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Note2: You can create index to any function if you hit the underline ‘_’ key when the cursor is at the very first position 

of the function argument. Even better, you can create index to a function by executing the function-creating-command 

with the underline key instead of SpaceBar or Enter key (example: \sin_1). 

 

Example 2: powering a function (consider step 2) 

 
1. Type ‘s i n’ and then hit the dot key to create the sine function. (Alternatively, type the \sin command and hit 

the SpaceBar to create the sine function. Even better, instead of the SpaceBar use the ALT+2 keystroke 

directly - in this case skip the step 2) 

2. Hit the ALT+2 keystroke to square the function 
3. Type ‘x’.  
4. You can then hit the Enter key to exit the function argument.  

 
Note: a function can be squared (or put to any exponent) from the function argument if the cursor is at the very first 

position of the argument. To make the exponent, you can use ALT+key combination, or the ‘^’ key. In fact, you can 

even execute a function-creating-command by the ALT+key or ‘^’ key. 
 

Example 3: understanding the ‘d’ differential 

 
1. Type the slash twice (‘//’) to create the fraction. The cursor is moved to the numerator 

2. Type d and then hit the dot key. This creates the differential without parentheses around its argument. 

(Alternatively, you could use the \d command to create the differential) 

3. Hit the ‘(‘ key to create parentheses and then type ‘x <ALT+2> + x’. 

4. Hit the Enter key to exit the argument of the ‘d’, and then hit the Enter key again to move the cursor into the 

denominator. 

5. Type the command \dx and hit the SpaceBar. There are several helping command (\dx, \dy, \dz, \dt) to quickly 

cast some more often used differentials. However we could also use the more general ‘d . x’ sequence. 

 

Example 4: integrals 

 
1. Type the \int command and hit the space bar to create the integral. The cursor is moved inside its argument. 

Alternatively we could use ‘i n t .’ sequence to create the integral sign. 

2. Hit the underline key ‘_’ to move the cursor into lower integration limit box (Note: we could create the 

integral by typing \int and hitting the underline key instead of the space bar – this immediately places the 

cursor into the lower integration limit box.) 

3. Type ‘x=0’ and then hit the Enter key to move the cursor into the upper limit box 

4. Type the ‘@’ key. The ‘@’ key is always converted into the infinity sign 

5. Hit the Enter key again – this will move the cursor into the integral argument box. 

6. Type the ‘e’ and then hit the dot key the fancy-looking ‘e’ constant. 

7. Type ‘-x’ and hit the enter key. The cursor moves back to integral argument box. 

8. Now type the ‘d . x’ sequence (alternatively you can cast the \dx command). The dx factor is created, but the 

cursor is still inside integral argument box - you will need to hit the Enter if you want exit. 

 

Example 5: creating a matrix (more…) 

 
 

1. Type the ‘[‘ key to create parentheses 

2. Type ‘a’ and then hit the SHIFT+TAB keystroke. The SHIFT+TAB keystroke creates new column (inserts 

the column separator) 

3. Type ‘b’ and hit the SHIFT+TAB keystroke again 
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4. Type ‘c’ and hit the SHIFT+ENTER keystroke now. The SHIFT+ENTER keystroke creates new row (the 

new row is created and filled with empty boxes) 

 
5. Type the ‘d’ and then hit the right cursor key or the Enter key (you should not press the SHIFT+TAB now 

because this would insert new column). 

6. Type the ‘e’ and the right cursor key again. 

7. Type the ‘f’ and then the SHIFT+ENTER keystroke to create final row. 

8. Type ‘g’, right key, ‘h’ right key, ‘i‘. Finally you can hit Enter to exit the matrix. 

 

 

 

Example 6: Typing a plain text (more…) 

 
 

1. Immediately as you started the new box, hit the space bar. This will convert equation box to text box. As a 

result, the blinking cursor will change its color from blue to green (you can hit the space bar again to toggle 

between equation/text box, but this only works while the box is still completely empty). 

2. Type ‘This is just a plain text’ and hit the Enter key to start new line. 

3. Type ‘written in the Math-o-mir.’ 

4. Type the \big command (and press the space bar) to enlarge the font a bit 

5. Type the \red command (and press the space bar) to change the color. 

 

 

 

Example 7: comparing variable modes (more…) 

 

This table shows what keystrokes you can use to enter two different expressions for two different 

variable modes.  

Expression example Variable mode Keystrokes 
Single-letter* a=x+y+ab  

 Multi-letter a=x+y+a<SpaceBar>b 

Single-letter a=’one+’two+’three  

 Multi-letter* a=one+two+three 

*the more efficient variable mode to type this expression example 

 

 

 

Example 8: editing an expression using keyboard (keyboard implanting) 

 

We wrote the following expression 

 
But we want to convert it to the following form 

 
1. Press and hold the SHIFT key, and then hit the left arrow key once. This will select the square root. 

2. Use CTRL+X to cut the square root (it is stored into internal memory – into the standard clipboard) 

3. Hit the backspace to delete the ‘/’ operator 
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4. Press and hold the SHIFT key, and then hit the left arrow key three times. This will select the 2x1y1 

expression. 

5. Hit the ‘/’ key. This will activate keyboard implanting function (a fraction line will be underlined under the 

selected expression). The cursor is moved into the denominator. 

6. Use CTRL+V to paste the square root sign, and then hit Enter key to move out of the denominator 

 

 

 

 

 

Example 9: editing an expression using keyboard and mouse (more…) 

 

We want to write the following expression 

 
 

1. Use double slash ‘//’ to insert the first fraction (alternatively, you can type ‘x’ and then hit the hash ‘#’ key – 

if you used this method, skip the next step.) 

2. Type ‘x’ in the numerator. Hit the Enter key to move the cursor to denominator. 

3. Cast the \sqrt command (or hit the CTRL+R) to insert root symbol.  

4. Use following keystrokes: x ALT+2 + y ALT+2. Then hit the enter key twice to exit back to the equation base 

line. 

5. Type ‘+’ and then use double slash ‘//’ again to insert second fraction (again, alternatively, you can type ‘y’ 

and then hit the hash ‘#’ key – if you used this method, skip the next step.) 

6. Type ‘y’ in the numerator. Hit the Enter key to move the cursor to denominator. 

7. Mouse click at the root sign of the first fraction. It will be copied to the denominator of the second fraction. 

 

Note: Instead of the mouse click in the step 7, we could use the autocomplete feature (if we were lucky enough that 

Math-o-mir marked the first denominator). In this case we could just hit the dot key to copy the root sign. 

 

 

 

Example 10: multiple cases 

 
1. Type ‘f’ and then hit the dot key to convert it to function (alternatively you could type \f command and then 

hit the ‘(‘ key or the Spacebar key or the Enter key)  

2. Type ‘x’ and hit Enter to exit the function argument 

3. Type ‘=’ 

4. Type \{ (this inserts the single bracket) 

5. Type ‘1;x<0’ and then hit ALT+Enter to start new line 

6. Type 0; 

7. Hit ALT+Spacebar to change typing mode to plain text (the cursor changes to green color) 

8. Write ‘otherwise’ and hit Enter key to return to baseline 

 

 

 

 

Example 11: multiple cases 2 

 
1. Type ‘x=1’ and then hit Alt+Enter to start the new line 

2. Type ‘y=2’ and then hit Alt+Enter to start the new line 

3. Type  ‘z=3’ 
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4. Type \} (this inserts the single bracket) 

5. Hit the TAB key to add some space (or you could just hit the spacebar two or three times) 

6. Hit the ALT+Spacebar to change the typing mode to plain text (the cursor goes green) 

7. Write “The solution”  

 

 

 

Example 12: typing variables that are containing the underline or the period character 

 
Because the underline key and the dot (period) key are used for special purposes, typing variables that contain these 

characters in their names is somewhat difficult. 

 

Example 12a:  A_1   Type: A [underline] [underline] 1 

Example 12b:  var_x_y Type: ‘ v a r [underline] [underline] x [underline] [underline] y 

Example 12c:  var_one Type: v a r [underline] [underline] o n e   

(the example 12c only works if the software is configured to prefer multi-letter variables. If not, you can try 

to use the following trick: ‘ v a r [underline] [underline] o n e and then hit the Shift+backspace twice to 

join last two characters.) 

Example 12d:  var.one Type: [Alt+Spacebar] var.one [Alt+Spacebar] 

(the period character can only be entered in the Text typing mode.) 

 

 

Finely adjusting position of the equation you type 
 

If you need to adjust the position of the equation that you are just typing, you can do it by using 

your keyboard. No need to grab the mouse and aim for the moving dot. Use the Spacebar+arrow 

combination (Spacebar+left/right/up/down). At each press, the equation will be moved for a few 

pixels. 

 
 

Using the mouse while the Typing mode is active 

 

While the Typing mode is active the mouse arrow has heart-like black shape . This way you 

know that behavior of your mouse will be different than usual. 

 

You cannot carry objects…. You can touch an expression and you can pick it up, but you cannot 

carry it around. As soon as you pick it up, it will be transferred and placed down at the position of 

the keyboard cursor. This way you can click around your document at various expressions (or at 

toolbox items) and easily copy them into the equation you are currently editing. 

 

In the advanced examples section, there is example 9 that is showing how to use mouse to grab 

existing expressions and insert them into the equation you are editing. 

 

If you right click at empty document area, the Typing mode will finish and the mouse arrow will 

reshape to standard windows shape. 
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Using the quick-type feature 
 

The quick-type feature enables entering text and math even without starting the Typing mode. This 

feature is aimed to be used in hand-drawing so that the user can type simple text/math without need 

to exit the hand-drawing mode.  

 

The quick-type feature works straightforward: you just move the mouse pointer to any place where 

you want to enter text and then simply start typing (without any mouse-click that would start the 

Typing mode). This way you can edit existing equations/text or create new one. 

 

The mouse pointer will automatically relocate as you type and you must be careful not to move the 

mouse. This is touchy, but can be useful to type few letters or words. 

 

Example: We draw a line using line drawing tool: 

 
 

We want to keep the hand-drawing mode, but we also want to name the start and the ending point 

of the line. We do this by pointing our pen-shaped pointer at the line starting point and then 

stroking the ‘A’ key (SHIFT+A, actually, as we want capital letters): 

 
 

Then we move the mouse pointer to the other end, and hit the ‘B’ key: 

 
 

As you can see, we did not need to exit the hand-drawing mode to write those letters and therefore 

we can now continue drawing lines as the line drawing tool is still selected. 

 

Tip: It is also possible to use the quick-type to create a plain text object. Just hit the space bar first 

(a green ‘T’ symbol will temporarily appear near the mouse pointer to indicate that the plain-text 

will be accepted) and then continue typing the text.  
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The Main Menu 

The File menu 

 
 

New – opens a blank document (you are asked to save your work before it is deleted) 

Open – opens document  

Save – saves document 

Save As – saves document under new name 

Autosave – you can choose from four options: Never, Low/Medium/High frequency. You can also 

load the autosaved document (the autosave function always saves into the ‘autosave.mom’ 

file). 

Print – prints the document 

Print Preview – enables previewing of the document prior printing 

Print Setup... opens windows printer setup dialog box. 

Recent documents (1..4) – opens recently used document 

Exit – Exits the Math-o-mir 

The Edit menu 

 
 

Undo – Undoes last action. There are 5 undo levels. 

Cut  - cuts the selection (copies data into windows clipboard)  

Copy – copies the selection into windows clipboard  

Paste – pastes from windows clipboard.  

Delete – deletes the selection. 

Find text – opens the find-text popup window  

Access Locked Objects – Objects that are locked cannot be selected unless you check this option. 

Once you select them, you can unlock them for further manipulation. 

 

 

Following options are only enabled when at least one object is selected. 

 

Copy Equation Image – copies bitmap image of the selection into windows clipboard. The image 

is ready for pasting into other software.  
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Save Equation Image – saves bitmap image of the selection into a file. File-Save dialog will be 

opened and you will be able to define file name and file type. Allowed file types are PNG, 

JPEG, and BMP. Transparent PNG is supported.  

Copy LaTeX Code – converts the selected expression/equation to LaTeX code. The LaTeX code 

is then copied into the windows clipboard (as a plain text) and you can paste it into any text 

editor. 

 

The View menu 

 

 
 

 

Zoom – you can choose various zoom levels for your document view (40...240%) 

 You can also choose whether the CTRL key must be used with mouse wheel for zoom 

action and whether mouse pointer position gets automatically adjusted when mouse wheel 

is used for zoom 

Zoom In – zooms in one step 

Zoom Out – zooms out one step 

Zoom to 1:1 – zooms to 100%. (It is possible to use F1 shortcut only if you checked the following 

option: ” Options->Keyboard->F1 sets zoom level to 100%”. Otherwise the F1 shortcut will 

display the Handy Help guide) 

Page – size and orientation of the displayed page (white region of the document view). Here you 

can also turn on the page numbering. 

Show Grid – displays or hides the grid. Grid is displayed as raster of green dots. 

Toolbox and context menu – you can choose the size of toolbox, toolbar and context menu. You 

can also show/hide the toolbar. 

Halftone rendering – only meaningful when the presentation mode is active. Use to display 

graphics with halftone rendering (integrals, brackets...) 

Presentation rendering – enables/disables the presentation mode. In presentation mode, equations 

look fancier, but are less editable. Display refreshing is slower, especially if the halftone 

rendering is enabled. (You can also use the F5 key to toggle the presentation mode.) 

The Options menu 

 
 

Selections – you can choose if  and how Math-o-mir will enhance showing selections 

- intelligent framing – drawing a dotted frame around expressions when it is not 

clear if the insertion point is inside or outside argument. 

- bold selections – math-o-mir will bold touched/selected objects 
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Moving dot – defines the size of the Moving dot. Also, moving dots can be made permanently 

visible 

Mouse – defines behavior of the mouse and the mouse wheel (scrolling speed, zoom/scroll, 

scrolling direction…) 

Keyboard – defines handling of the keyboard 

- Fix font for numbers – when numbers are written, always use first font. 

- ALT for menu access – ALT+F, ALT+E, ALT+V activate main menu 

(otherwise, these keystrokes are used to enter Greek symbols). 

- F1 to set zoom level to 100% - check to redefine the usage of the F1 key. 

- Use CapsLock to toggle typing mode – to enable using the CapsLock to quickly 

toggle the math/text typing mode 

- Allow comma as decimal separator – if in your country you use comma as a 

decimal separator in numbers, you might want to check this option 

- Use complex indexes – allows placing math operators into indexes 

- Prefer multi-letter variables – to make typing of multi-letter variables easier 

- Prefer single-letter variables – to make typing of single-letter variables easier 

Output Image – defines how output equation bitmap image is to be processed 

- Size – defines the size of the image 

- Presentation rendering – if the presentation mode is used when rendering 

- Halftone rendering – if the halftoning is used when rendering 

Font size – defines the size of font when new equation is started 

Parenthese height – defines the default height of parentheses 

- small – parentheses are of height of the font 

- large – parentheses completely embrace its content 

- medium – parentheses embrace its content to the point it is clear enough what 

their content is. 

Grid and guidelines– defines the resolution of the grid and defines if objects are snapped to 

guidelines. 

Symbolic computation – defines if the symbolic computation is used or not. And defines basic 

rules with symbolic computation. 

Save settings – saves current Math-o-mir settings (the Options menu and toolbox settings) 

- Save as default – these settings are automatically reloaded when Math-o-mir 

starts (settings are saved into the Mathomir.set file) 

- Save as... – you can define your own file to save settings 

- Load... – you can load settings from previously saved file 

 

The Help menu 

 

 
 

Handy help – displays Math-o-mir handy help. 

About Math-o-mir – displays Math-o-mir about box. 
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Exporting equation images 
 

You can export equation images (bitmaps) in following ways: 

- copy them to windows clipboard 

- save them to graphics file 

- convert them to LaTeX 

 

To copy equation image into windows clipboard, touch (with mouse) the expression you want to 

copy, and then press the F9 key. If you want to copy image of more than one expression, you have 

to select them (mouse click and-drag action to draw selection frame around them) and then press 

the F9 key (or choose the Edit->Copy Equation Image option). 

 

The same procedure is used if you want to copy the image to file, only you then use the F8 key 

instead. When saving into the file you can choose following options: 
- 32 bit PNG file (transparent) 

- 24 bit PNG file 

- 8 bit PNG file 

- 1 bit PNG file 

- JPEG file 

- 24 bit BMP file 

- 8 bit BMP file 

To adjust the size and rendering quality of the resulting equation image, use the options in the 

Options->Output Image. 

 

LaTeX export  

 

You can also convert and export equations in LaTeX form. The procedure is identical – 

touch/select desired equation(s) and then press the F6 key. The LaTeX code will be generated and 

copied into the windows clipboard, as a plain text. You can then paste this code into any text 

application you want.  

 

For example, the equation ‘a+b=c’ exported as LaTeX would look as below: 

 
a +b =c 

 

Note that the bare LaTeX code is generated – you will have to encapsulate it into appropriate tags 

depending on your needs. 
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Headlines, Labels and Hyperlinks 
 

When you want to enter a headline into your document, you can use one of following three 

commands: \h1, \h2 or \h3. Any of these three commands will convert a normal box into a 

headline box. Any text contained in such headline box will be displayed in specific blue-green 

color for visual distinctiveness. Note that font size is automatically adjusted – largest in the \h1 

case, smallest in the \h3 case: 

 

 
 

Note that you can either first type the headline text, and then cast the headline command (/h1, /h2 

or /h3) or you can cast the headline command while the box is still empty. Note also that you can 

change the color of the headline text if you want. 

 

 

Labels 
 

You can create a label by casting the \label command, or by choosing the label element from the 

toolbox. The label element consists of a text box decorated with a small purple square. You should 

type the unique label-text inside this text box. 

 

 
 

In the above example, a label element is added behind the “Here is the label:” text. The entered 

label-text is “my label” (the label-text is displayed in blue color). One example how labels could be 

used, is to label equations like in the following example: 

 

 
 

Labels (and headlines) represent anchors where you can link your hyperlinks. 

 

 

Hyperlinks 
 

You can create a hyperlink by casting the \link command, or by choosing the hyperlink from the 

toolbox, or by converting math/text elements to hyperlinks. You can create internal hyperlinks (i.e., 

links that point to labels or headlines in the same document), or you can create external hyperlinks 

(i.e., hyperlinks that point to external files, programs or web pages). 
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A hyperlink element consists of a text box decorated with a small purple arrow. In this text box 

you should enter a descriptive hyperlink text. In addition, a hyperlink element also contains the 

hyperlink-command-text that is not visible.  

 

 
 

When you mouse-click at a hyperlink, the hyperlink is executed. 

 

To edit the hyperlink-command-text, you must right-click at the hyperlink element. The following 

menu will open: 

 
 

Here you can click at the “Hyperlink” option - an input box will be displayed where you can enter 

the hyperlink-command-text for the hyperlink element. In the following example a link to a web-

page (http://mathomir.wordpress.com) is defined: 

 

 
 

If you instead want to link to an internal label or headline, you can just click one from the list of 

internal links (note: labels are listed inside parentheses, while headlines are not).  

 

More examples how to define external hyperlink-command-text is here: 
- http://www.google.com – opens the google homepage 

- g:\readme.txt – opens the ‘readme.txt’ file 

- .\example.mom – opens the ‘example.mom’ file 

- mailto://mathomir@gmail.com – opens a mail software 

- c:\windows\notepad.exe – opens the windows notepad 
 

Advanced: Any external hyperlink is executed by providing the hyperlink-command-text to the Windows ShellExecute 

command. It therefore depends on system configuration how external hyperlinks will behave on each system. 

 

As you can see, the descriptive text written inside a hyperlink element text-box differs from the 

actual hyperlink-command-text. However, if the hyperlink-command-text is not defined, the Math-

o-mir will try to execute the descriptive text directly. 
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Matrix (table) editing 
 

In Math-o-mir you can work with matrices and tables. You can construct a matrix/table using 

keyboard. Alternatively you can start by choosing some predefined empty matrices from the 

toolbox. 

 

In the toolbox, you can find several predefined matrices under the parentheses submenu. You will 

find matrices in form 1x2, 1x3, 2x1, 3x1, 2x2 and 3x3. 

 

 
 

If you place for example a 3x3 empty matrix in the document, you will see the following: 

 
There are 9 empty boxes in 3x3 formation. As you already expect, you can mouse click at any 

empty box and write your expressions. You can also drop down anything at an empty box.  

 

Matrices are edited as any other objects. For example, if you move your mouse over a matrix, some 

parts of the matrix will get touched (blue). You can also find many insertion points inside the 

matrix where you can insert more math. 

 
However, you can also touch column and row insertion lines. Column insertion lines can be found 

between columns while row insertion lines can be found between rows. There are also column and 

row insertion lines at matrix edges. Two examples below show a column insertion line (between 

columns 1 and 2) and row insertion line (between rows 1 and 2). When touched, the column and 

row insertion lines are displayed in blue color. 

    
 

When you mouse click at a column insertion line, the new column is inserted. A click at a row 

insertion line will insert new row. In the example below the column insertion line is clicked. New 

empty column is inserted and Typing mode starts (blinking blue cursor appears) so that you can fill 

in the new column. 

 
Therefore, by clicking at row/column insertion lines you can expand your matrix/table.  
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Matrices can be touched. You can touch the whole matrix including the parentheses (point at 

parentheses) or without parentheses (point at corners of parentheses content, just inside 

parentheses). The two examples show the difference – the left example includes parentheses, and 

the right one doesn’t. 

    
Column and row separators become visible (represented as small triangles) when the whole matrix 

content is touched. 

 

You can touch a single cell of a matrix by pointing your mouse at lower or upper edge of the cell. 

You can also touch several cells by holding down the SHIFT key and dragging mouse arrow over 

cells that you want to touch. In the example below, the mouse was pointed at the ‘a’ cell, then the 

SHIFT key was held, and the mouse was moved to the ‘e’ cell.  

 
Once you have cell(s) selected, you can pick them up by mouse click (or CTRL+C) or delete them 

using the DEL key (or CTRL+X). Note that by selecting the entire row (or column) and by hitting 

the DEL key, you will wipe it out of the matrix. This way you can reduce the size of your matrix.  

 

When you carry rows and columns with your mouse, you can insert them into any matrix by 

clicking at column or row insertion point. In the example below, the 2x2 ‘abde’ fragment was 

picked up and placed just below the ‘g’ cell (the row insertion line below the ‘g’ cell). As you can 

see new rows are created and filled with ‘abde’ values. Two empty cells are padded. 

 
In the similar way you can place rows and columns that you are carrying over existing cells. 

Instead of placing at row/columns insertion point, just place them down at some particular cell (the 

whole cell must be touched, by pointing your mouse at upper/lower cell edge). In the example 

below, again the 2x2 ‘abde’ fragment was picked up and placed down at the ‘h’ cell. As result, the 

‘h’ and ‘k’ cells are replaced with ‘a’ and ‘b’, but also a single new row is appended and filled with 

‘d’ and ‘e’. 

 
When you carry rows and columns and you click at a normal insertion point or at any element in 

the matrix, you will create matrix-in-matrix structure. In the example below, again the 2x2 ‘abde’ 

fragment is placed down at the ‘h’ element (clicked at the ‘h’ while the ‘abde’ was carried). The ‘h’ 

element is replaced by new matrix ‘abde’. 
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Matrix editing with keyboard 

 

Matrices can also be constructed by keyboard. For example you can start by entering parentheses 

(the ‘[‘ was pressed to create parentheses). 

 
Then you write data for the first cell. After you finish the first cell, you press the Shift+TAB keys 

to create new cell and so on. In the example below, three cells are created ‘a’, ‘b’ and ‘c’. (The 

following key sequence is used: a Shift+TAB b Shift+TAB c). 

 
To start new matrix row, press the Shift+ENTER keystroke. The cursor will jump to new line. The 

new line will be padded with empty fields 

 
You fill the first cell, then press the Right Arrow Key (or Enter) and cursor will jump to the next 

field. Repeat this until you finish the whole row (you can then use Shift+ENTER to start another 

row, if you need). 

 
Note that when you are editing a not-first row, you don’t use the Shift+TAB keystroke to jump 

from cell to cell. Instead you use the Right Arrow keyboard key or the Enter key. This is because 

the Shift+TAB creates new columns. If you press the Shift+TAB instead the Right arrow, you will 

unwillingly create new column, and your matrix will look something like below. 

 
 

You can also select cells, rows and columns by holding the SHIFT key and using keyboard arrow 

keys. Once the selection is made you can delete it by using the DEL key (if whole rows or columns 

were selected then those rows/columns will be removed, but otherwise cells will be emptied) or 

cut/copy by using CTRL+X, CTRL+C keystrokes. Copied cells you can paste using the CTRL+V. 
(For more info about using keyboard to cut/copy/paste, see here…) 
 

In the text control box, you will find two buttons that can be used to insert new rows and columns 

with mouse click. 
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Adding borderlines to tables/matrices 

 

You can decorate your tables/matrices by defining borderlines. You can right-mouse-click at a row 

or column insertion line to define the line – the following menu appears: 

 
 

It is also possible to select one or more cells and right-mouse-click to open a menu with options to 

define table lines (internal lines and borders). 

 
 

An example of a table with defined border lines (double), internal lines (single) and multiline text 

with various justifications is shown below: 
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Hand drawing 
 

 

Hand drawings can be created to illustrate your equations. To begin drawing, choose any hand 

drawing tool from the toolbox. Hand drawing tools can be found at toolbox bottom. 

 

 
 

Following tools are available: freehand, line, rectangle/square, ellipse/circle, tiny eraser (pencil 

eraser), eraser, coordinate system, linear and logarithmic networks, 5-edge and 6-edge polygon, 

ellipse and rectangle drawn from center, sine function, parabolic function, triangle (right-angle and 

isosceles), sector and segment of circle. 

 

When any hand-drawing tool is selected, the hand-drawing mode will start and the mouse arrow 

will change into a pen-like shape .  You can select the desired line color and line thickness from 

the color-box. Then you start drawing by click-and-drag mouse (pen) over your document. 

 

 
The color box is displayed below the toolbox. 

Here you can choose line color and line thickness. 

 

There are alternative and possibly quicker ways to select a hand-drawing tool. One possibility is by 

calling up the handy hand-drawing-popup toolbox where you can choose from 9 most often used 

drawing tools. There are two ways to display the hand-drawing-popup: 

 

- hit the F4 key 

- long right-mouse-click (right-click at document area and hold the button down for about 

0.5 seconds; when a pale-blue box shows, release the right mouse button) 

 

 
 

When the hand-drawing-popup opens, the tool that you last used will be automatically selected. If 

this is the tool that you want to use, just move your mouse pointer away and the popup will close 

by itself. If you want another tool, mouse-click on it or use 1-9 keys to select it. Using subsequent 

F4 key hits it is possible to cycle through 4 most basic tools (freehand, line, rectangle and 
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ellipse)… If you just want to close the handy popup without selecting any tool, right-mouse-click 

on it or hit the Esc key.  

 

In theory, an even quicker way to directly select among 9 most often used hand-drawing tools is by 

using Alt+1…Alt+9 keystrokes (this works if the Typing mode is not active and the mouse pointer 

not aiming at any math/text). Tools are numbered in the same order as in the hand-drawing-popup: 

 
- Alt+1 – line drawing tool 

- Alt+2 – freehand drawing tool 

- Alt+3 – arrow drawing tool 

- Alt+4 – ellipse drawing tool 

- Alt+5 – rectangle drawing tool 

- Alt+6 – pencil-eraser tool 

- Alt+7 – centered ellipse drawing tool 

- Alt+8 – centered rectangle drawing tool 

- Alt+9 – eraser tool 

 

You can also start the hand-drawing mode by clicking at either line color or line thickness from the 

color-box. This will select the last-used hand drawing tool… Last but not least, recall that you can 

define your own keyboard accelerator (Ctrl+some key) to any hand-drawing tool to quickly access 

it. 

 

 

To exit the hand drawing mode, either right-mouse-click at document area, or press the ESC key. 

You can also temporarily ‘exit’ the hand drawing mode by holding down the CTRL key (this is 

handy when you need to, say, move an equation a bit or edit drawing nodes or do any other simple 

editing that cannot be done while a drawing tool is selected). 

 

 

Touching and moving hand drawings 

Similar to equations, all drawings can be touched (with the standard mouse arrow ), picked up, 

carried away and placed down. You can also touch more than one drawing by holding the SHIFT 

key while you touch them with the mouse pointer.  

 

 
One hand-drawing shape is touched by the mouse arrow – becoming light-blue 

 

Drawings don’t have moving dots. If you want to move a drawing around, simply click anywhere 

on it and then move it (the click-and-drag action). If you just mouse-click on a drawing (no click-

and-drag) you will create a copy of it (pick-up) that you can carry and place-down whenever you 

want. 

 

Right-mouse-click on a drawing will open the context menu. This way you can change line color, 

width and style; stretch, mirror and rotate; group, ungroup, combine and break-apart… Drawings 

can be grouped together with equations (but not combined). 

 

The context menu will contain a somewhat different options, depending on the drawing you right-

clicked. For example, open-path drawing will have option to close it, while closed-path drawing 
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will have option to fill it with a solid color. Also, if you selected/touched more than one drawing 

you will be given options to group and/or combine them. 

 

Tips:  

 
• If you hold down the SHIFT key while drawing, depending on what drawing tool you use, you will: draw perfect 

horizontal/vertical/45_degree lines, perfect squares, perfect circles, equilateral triangles... The same effect can be 

achieved if you draw by holding both mouse buttons down (that is, holding down the right mouse button behaves 

as if you hold down the SHIFT key – useful when you are lazy to reach for the keyboard). 

 

• Similarly, you can hold down the SHIFT key (or the right mouse button key) when using the free-hand drawing 

tool to draw straightened horizontal/vertical lines. It is quite difficult to draw straight lines with a mouse, so the 

Shift key is here to help you. 

 

• When using rectangle or ellipse drawing tool, you can also draw horizontal and vertical lines by drawing really 

thin (few pixels only) rectangles/ellipses. A very thin rectangle/ellipse will be degraded to a line. 

 

• To quickly draw a section line or a curly brace, you don’t need to choose any drawing tool at all. Read more about 

it in the Drawing lines and curly braces section. 

 

• If you hold down the ALT key while you are drawing, you will temporarily toggle the snap-to-grid option. 

 

• After you draw something, you can hit the Enter key to select the last drawn object. Once you have it selected you 

can modify its color and line thickness from the color box. An alternative way to select the last drawn object is by 

mouse clicking the ‘select last’ button in the color-box. (Note: you can click the ‘select last’ button several times 

or hit the Enter several times to select several last drawn objects) 

 
 

• In fact, it is not needed to select the last drawn object for simple operations as changing line thickness or 

line color. After you drawn something, you can just right-mouse-click at the desired color or line 

thickness from the color box to change the line properties of the last drawn object. This is effective if 

you forgot to change the line properties before drawing.  

 

 

 

Adding line endings 

 

You can add line endings to simple open-path curves (those that have no branches, no vertices and 

no loops). Just right-click at the curve and the menu will open where you can choose appropriate 

line ending. 
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There are three possible line-endings: wide arrow, narrow arrow and a dot/box.  

 

If you right-clicked at the open-path curve very near (within few pixels) from one of its ends, the 

line-ending will be only applied to that end. Otherwise, the line-ending will be applied to both ends 

 

Editing nodes 

 

Every drawing consists of nodes and line fragments. To edit nodes either: 

- hold the CTRL key and touch the drawing with your mouse pointer (nodes will show up) 

- in the color-box enable the ‘node edit’ option (nodes will show up on every drawing you 

touch with your mouse pointer) 

 
 

The following picture shows a freehand line with nodes visible and ready for node-editing. 

 
Nodes can be moved by mouse click-and-drag. If you move one node exactly to the neighbor node, 

then these two will be joined into single node (this way you can delete nodes). If you hold down 

the Shift key while you are moving nodes neighbor nodes will also move a little to make your 

editing smoother. (Note: instead of holding down the Shift key, you can hold down the right mouse 

button key – that is, drag the mouse with both keys pressed.) 

 

To add a node, you can hit the SpaceBar key while nodes are visible and your mouse is pointing at 

the line. Alternatively, you can right-click at desired location choose the “Add node” option from 

the context menu. 

 

 

 

Specific modifications of basic drawing shapes 

 

Some basic drawing shapes can be modified by right-mouse-clicking on them and then choosing 

the specific option from the context menu: 

 

• line – you can choose ‘Add arrows’ option to add arrows at both ends of the straight line. 

This can be useful when you draw dimension lines. 

• ellipse/circle/hexagon – you can choose ‘Add center point’ to add center point to the 

ellipse, circle or hexagon 

• coordinate system – you can choose ‘Add grid lines’ to add coordinate grid to coordinate 

system 
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Stretching and rotating   

 

To stretch or rotate drawings freely, using your mouse, you must first select drawing(s) that you 

want stretch or rotate. By selecting them, four red squares (stretching handles) will be displayed at 

corners of the selection. 

 

 
 

Left-mouse-click-and-drag on any of the stretching handles to stretch the selected drawing(s). (By 

holding down the Shift key you will keep the aspect ratio. Alternatively you can hold down the 

right mouse button to keep the aspect ratio – that is, stretch with both mouse buttons pressed.) 

 

Right-mouse-click-and-drag on any of the stretching handle will rotate the selected drawing(s) 

around the selection central point. 

 

A more controlled way to stretch and/or rotate is by right-mouse clicking at the selected objects 

and then choosing options from the context menu. There are several quickly-selectable stretching 

degrees (-50%, -15%, -5%, +5%, +15%, +50%) and several quickly-selectable rotating degrees 

(5º, 15º, 45º, 60º, 90º). However, you can also stretch and rotate for some exact percentage or 

angle-degree: click at the ‘??’ options to type in the exact percentage or degree of arc. Note that 

you can type in the stretching percentage as, for example: +30 (meaning: increase 30%), -30 

(meaning: decrease 30%) and 30 (meaning: set to 30% of the current size). 

 

 

 

Grouping and combining   

 

Drawings (and math expressions) can be grouped and then ungrouped at will. To group drawings 

and/or expressions, select them all, then right-click to the selection and choose ‘Group’ from the 

context menu. 
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To ungroup, right-click to the group and choose ‘Ungroup’ from the context menu. 

 

   
selection of three objects  single group selected 

 

 

Combining is only possible with drawings (it is not possible to combine drawings with equations). 

By combining, one single non-separable drawing will be created (it can, however, sometimes be 

broken apart). Combining sometimes has some advantages over grouping as it creates simpler and 

more easily editable objects.  

 

 

Predefined drawings  

 

Several predefined handy drawings can be selected from the toolbox under the ‘underline’ item. 

 

 
 
The underline – used to divide math sections in your document. You can place it to the document by click in which 

case it extends to the whole page width, or you can place it by click-and-drag action to control its length. The underline 

can draw horizontal, vertical and 45-degree lines. (Notice: when this tool is used inside the Drawing box, the line 

thickness is fixed to hair-thin. The same happens if you hold down the Shift key while you are drawing the underline.) 

The ‘curly’ bracket – use click-and-drag action to place it into your document. It can be both, horizontal and vertical, 

depending on the way you drag your mouse. 

The arrow, the freehand arrow – use click-and-drag action to place it into your document. 

The checked sign, the exclamation sigh, the question-mark sign, the cross sign – use mouse click to place them 

down, or click-and-drag to control their size. 
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Diagonal line filling tools – these two tools can be used to fill shapes with left or right diagonal lines. Click-and-drag 

your mouse and diagonals will be painted without crossing lines of existing drawings. 

The Drawing box – click-and-drag to place it into your document. More about drawing boxes in the next chapter. 

The Function plotter – click-and-drag to place it into your document. More about the Function plotter you can find 

further in this manual. 

The Bitmap box – click-and-drag to place it into your document. You can then load an image into the bitmap box. The 

bitmap box is also created when you paste a bitmap image into the document using Edit->Paste (or CTRL+V). 

 

 

 

List of keyboard functions useful when drawing  

 
SHIFT  Used to force kind of symmetry while some drawing tools are used. Force 

rectangle tool to draw perfect squares, or ellipse tool to draw perfect circles. It 

forces line tool to draw vertical, horizontal or 45-degree lines. It straightens the 

line drawn with the freehand drawing tool… The Shift key can also assist for 

smoother node editing. 

Note that in many cases, instead of holding the Shift, you can hold down the right 

mouse button (that is, draw with both mouse buttons held down). 

CTRL  Used for three purposes: 

- to temporarily exit the drawing mode (white mouse pointer is shown as long 

as the CTRL is held) in order to arrange/move drawings or to invoke 

context menu without leaving the drawing mode 

- to edit nodes of drawings without need to enable the ‘nodes edit’ option in 

the color-box 

- to temporarily show the cross-hair cursor (to permanently show the corss-

hair cursor, enable the ‘crosshair cursor’ option in the color-box). 

ALT  Used to toggle snap-to-grid option. 

(If used inside the Drawing box, it is used to toggle the snap-to-key-node option. 

Read about drawing boxes in the next chapter for details.) 

ALT+1…ALT+9 To quickly select a drawing tool (line, freehand, arrow, circle, rectangle, pencil-

eraser, center-circle, center-rectangle, eraser) 

ALT+R, ALT+G, ALT+B To quickly select the line color (red, green, black). 

ALT+T, ALT+M To quickly select the line thickness (thin, medium). You can also use ALT+S for 

medium thickness. 

Any letter or number key Even while drawing mode is active, the quick-type feature is enabled and you can 

type simple expressions or numbers without need to exit the drawing mode. 

F4  If the drawing mode is not active, then F4 starts the drawing mode and selects the 

very last used drawing tool. If the drawing mode is already active, it cycles 

through four most important drawing tools (rectangle, line, ellipse, freehand) 

F2/F3  Can be used to zoom_in / zoom_out (However, the mouse wheel is more handy to 

do the same, if you have it. Note that, depending on how you configured Math-o-

mir, you might need to hold down the Ctrl key to zoom with the mouse wheel.) 

F1  Used to set zoom level to 100% (1:1). This only works if you checked the 

‘Options->Keyboard->F1 sets zoom to 100%’ option. 

Enter Selects the last-created object. (The last-created object can also be selected by 

clicking at the ‘select last’ option from the color-box.) 
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Drawing boxes (technical drawings) 

 

A drawing box can be placed to your document. The drawing box is an active object inside which 

you can draw drawings of more technical nature. The Drawing box will show a simple drawing 

toolbox in its upper right corner and the coordinate grid whenever the mouse arrow is inside it. No 

Typing mode will start if you accidentally click at empty area inside the drawing box. Further, 

some figures (freehand, ellipse) are drawn with higher precision inside the drawing box… 

However the main advantage of the drawing box is the existence of the coordinate system and the 

existence of the command-line entry. 

 

The drawing box can be found in the main toolbox, under the ‘underline’ item. 

 

 
 

The example picture below shows a drawing box while a line is being drawn. The toolbox is in 

upper right corner (line tool, rectangle tool, ellipse tool, center-drawn ellipse tool, helping-lines 

tool, eraser, tiny eraser, diagonal line tools). At the upper left corner, coordinates of mouse pointer 

are displayed. 

 

 
 

 

If more that one item is selected inside the drawing box, its toolbox changes to include options for 

gouping/ungrouping, aligning and mirroring. 



 83 

 
 

 

At the bottom left corner you can see Cartesian coordinate system origin point (small gray circle) 

and unit lengths (short gray lines). You can use your mouse (click-and-drag) to readjust them as 

you wish. Note that by moving x-axis unit length, you will adjust both, x and y, unit lengths, while 

y-axis unit length can be adjusted independently. 

 

 
 

When no drawing tool is selected (that is, standard white mouse arrow is shown) then you will see 

‘>’ sign at the upper left corner of the drawing box. 

 

 
 

 

By clicking at it, you will activate the command line entry where you can type several commands: 

 

- line length[,angle] – will draw a line of specified length and angle. Example: line 10, 45 

- line x1,y1,x2,y1 – draws line from point x1,y1 to point x2,y2 

- vline length– will draw a vertical line of specified length 

- rect width[,height] – will draw a rectangle/square of specified width and height. 

- rect x1,y1,x2,y2 – draws rectangle/square from point x1,y1 to point x2,y2 

- ellipse width[,height] – will draw an ellipse of specified width and height 

- ellipse x1,y1,x2,y2 – draws ellipse/circle specified with rectangle x1,y1 – x2,y2 

- circle diameter – will draw a circle of specified diameter. Example: circle 10 

- rotate angle – will rotate the last drawn object by specified angle 

- move x[,y] – will move the last drawn object by specified x and y span. 

- hair; thin; medium; thick – will change line thickness of the last drawn object 

- black; gray; red; green; blue – will change line color of the last drawn object 

- dashdash; dashdot – will change line type of the last drawn object 

 

Note that commands are executed by the Enter key. You can type more than one command at once 

by separating them with the ‘;’ character (for example: line 5.3,45; thick). 

 

Instead of typing x,y coordinate pairs manually, you can also mouse click anywhere inside drawing 

box and coordinates will be added to command line (if the command line is active). 
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The ALT key will act differently while you are drawing inside a drawing box (outside the drawing 

box it acts as ‘snap-to-grid’ toggle). Inside the drawing box, the ALT key will snap to key-nodes of 

existing drawings. The key-nodes include: 

 

- starting and ending line points 

- line intersection points 

- sharp edge points 

 

When you hold the ALT key (or when the ‘snap-to-grid’ option is selected from the menu), by 

moving your mouse pointer near any key-node inside drawing box, the key-node will be detected 

and pointed out by small green circle. Mouse actions will snap to key-nodes and this can be useful 

to make technical drawings. You can use the same trick when you move drawings with mouse to 

perfectly align a key-node to other key-node.  
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Symbolic computation 
 

Important: If you don’t use the symbolic computation feature, you can disable it by unchecking: 

Options->Symbolic Computation->Enable. This way the Math-o-mir will become handier for pure 

equation editing. 

 

The Math-o-mir includes symbolic calculator to assist you with math. The purpose of the symbolic 

calculator is not to provide solutions that are too difficult for you to solve yourself. Instead, it 

should be used to relieve you of the burden of boring steps.  

 

The symbolic calculator is activated by touching some expression, and then right-clicking at it. The 

context menu is opened, and any found solution is added at the bottom of the context menu as soon 

as it gets calculated. At no moment Math-o-mir knows exactly what you want to do, but it can 

provide several calculated options for you to select.  

 

Example... imagine you have the following two equations: 

 

 
 

You can click at the ‘y’ in the first equation to extract it out. The following context menu appears: 

 
 

At the bottom of this context menu you have one  ‘solution’ found: y=2m-x. We choose the black 

square left of the solution – this way we will ‘pick up’ the solution and it will become ‘attached to 

our mouse’. Then we will ‘place down’ the solution next to the first equation, so we will have: 

 
 

We can, for example, do the same with the second equation. The ‘y’ gets extracted. 
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Now, the ‘2m-x’ can be selected and placed over ‘y’ so we will get: 

 

 
 

We can touch the right side of this equation (either, with the ‘=’ included or not) and then right 

click. Solutions will be provided: 

 

 
 

Suppose that we liked the first solution, so we click directly on it and the equation gets modified 

to: 

 
 

 

Options in the context menu 

 

Several solutions can be provided in the context menu. Left of every provided solution there are 

two mini buttons – a small triangle and a small rectangle. 

 

 
 

Clicking at the solution itself – the original equation/expression gets modified 

 

Clicking at the triangle – the new equation/expression is created, just below the original one, with 

given modifications included. 

 

Clicking at the rectangle – the solution is ‘picked up’. That is, it gets attached to mouse and you 

can latter place it down, anywhere you want (as with any item that you 

carry). 
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Using symbolic computation with keyboard 

 

When you are typing an expression with your keyboard, you can enter the question mark ‘?’ twice 

to start the symbolic calculator. The expression left of the equal sign will be calculated, and 

solutions will be given in a popup menu. You can then choose the solution with keyboard arrows 

and the Enter key. 

 

In the example below, a simple expression (215+231*21) was written, and then the ‘?’ was entered 

twice (‘??’). This popped up a menu with single solution ‘5066’ 

 

 
After pressing the ENTER key, the solution is inserted in the equation, and Typing mode is 

resumed: 

 
 

 

What can Math-o-mir calculate? 

 

1. Simple calculations 

 

 
2. Simple factorizations 

 
3. Fraction reducing 

 
4. Rationalize a denominator 

 
5. Calculate determinant 
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6. Matrix inverse (small matrices only) 

 
 

7. Number rounding (and integer factorization) 

 

 
 

8. Variable extraction (within a well-formed equation, right click at the variable you want to 

extract) 

 
 

9. Casting to polynomial-like form (within a well-formed expression, right click at the 

variable you want to use) 

 
 

10. Make simple derivations (you must put expression that you want to derive, into the d/d 

structure, and then right-click) 

 
 

11. Substitute variables (you must pick up an equation from which you want to substitute a 

variable, and then, carrying this equation right-click at the wanted variable in an other 

expression. This way you gave following instruction to Math-o-mir: “extract the variable I 

clicked on from the equation I am carrying, and substitute it”.) 

 
 

12. Solve simple (linear mostly) and complete systems of equations. The Math-o-mir will 

assume that all variables are unknowns. This is mostly used to insert values into general 

equations. (you must select all relevant equations – by dragging the selection frame around 

them – and then right click to the selection) 

 
 

EXAMPLE: there is following equation, we want to cast numerator of the fraction into 

polynominal-like form: 
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Right click at any ‘x’ in the numerator. The context menu appears, the last option is interesting to 

us. 

 
 

We press the triangle next to it and the result is new equation, just below the original one: 

 
 

 

It takes practice to learn when and how the symbolic computation feature can help you.  

 

 

Function Plotting 
 

Simple functions can be plotted with Math-o-mir. You start by placing the function plotter into 

your document.... choose the function plotter from the toolbox, and place it (by click and drag 

action) anywhere into your document. 

 

The function plotter can be found under the ‘underline’ subtoolbox: 

 

 
 

When placed on the document, the function plotter looks like this 
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However, if you hover your mouse above it, additional controls become visible 

 

 
 

auto adjust button – redraws the function, and adjusts the ‘y’ range (the ‘x’ range remains 

unchanged) 

zoom out button – broadens both, ‘x’ and ‘y’ range 

zoom in button – lets you zoom any particular part of the function – by dragging a zoom-in frame 

with the mouse 

linear/logarithmic button – toggles between linear/linear, linear/logarithmic, 

logarithmic/logarithmic and logarithmic/linear style 

function definitions – Here you can type in functions that are to be plotted (or edit them). Up to 

three functions can be plotted. 

analysis – click to toggle analysis/normal mode. In analysis mode the plotter shows function local 

minimums, maximums and intersection points (if two or more functions are 

plotted at the same time). For the ‘black’ function it also computes function 

integral for the displayed range. 

 

In addition, there are also four range arrows, that are visible when mouse is hovering above them. 

By clicking on them, you can manually define x and y coordinate minimum and maximum. 

 

 
 

Another way to quickly re-define coordinate axis min and max is by click-and-drag action at the 

grayed portion of the plotter window. 

 

 

How to plot a function? 

 

1. Write a function (equation) anywhere 

2. Place the function plotter nearby 
3. Pick up the function (with mouse) and drop it to the function plotter 

4. Function gets plotted. 
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EXAMPLE: A function was written: F=12 sin(m/10),  then the function plotter is painted near it. 

 

 
 

The function is ‘picked up’ by mouse, and dropped into the function plotter (to the white area). 

Function gets plotted immediately (note that ‘F’ and ‘m’ coordinates are named.) 

 
 

 

Tips: 

 

- You can ‘move’ the plotted function by clicking at the white portion of the function plotter 

and dragging the mouse (click and drag). 

- If you drop the function directly to any ‘function definition’ button, you will draw the 

function in that color 

- by clicking at the ‘function definition’ button, you can edit the drawn function. You can also 

delete the function by keyboard (the DEL key) to remove it from the function plotter. 

 

 

How to write a proper function  

 

The Math-o-mir can plot functions of single variable. Functions of two variables are not plotted 

properly. The proper form is shown in examples below: 

 

 
The expression is plotted. The horizontal coordinate is named ‘n’, while the vertical 

coordinate remains unnamed. 

 
The expression is plotted. The horizontal coordinate is named ‘g’, while the vertical 

coordinate remains unnamed. 

 
The equation is plotted. The horizontal coordinate is named ‘x’, while the vertical is 

named ‘y’. 

 
The function is plotted. The horizontal coordinate is named ‘t’, while the vertical is 
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named ‘f(t)’. 

 
The ‘e^x’ is plotted. The horizontal coordinate is named ‘x’, while the vertical is 

named ‘ab+x’. 

 

Following examples are invalid and cannot be properly plotted in Math-o-mir. 

 

 
Cannot be plotted because contains two variables (on the ‘right’ side of equation) 

 

Cannot be plotted because contains unsupported operator/function. Math-o-mir 

only supports limited range of operators and functions. Examples of unsupported 

operators/functions include: summation/product operator, integrals... 

 

 

 

 

Managing documents 
 

By default, Math-o-mir saves its files with .mom extension.  

 

In the SaveAs dialog, using the ‘Save as type’ combo-box, you can choose to save your document 

in several different formats (all of them will have .mom extension): 

 

MOM file (1.x) This is legacy standard format – the XML textual file that can 

be edited in any plain-text editor when necessary. 

Specification of the format is out of scope of this manual. 

MOM file (2.x) This is optimized format (still XML) that generates smaller 

files 

MOM encrypted file This is both, compressed and encrypted – you will need to 

provide a password before the document is saved. Without the 

password, no one will be able to open the document. Note that 

the encryption is weak. 

MOM exam file This is used to store exam files that can be later open by 

students. This feature is added to support clasroom usage. 

More about it in the next chapter. 

MOM view-only file This format is used to store files that are protected from 

editing. When such file is loaded, the Toolbox will disappear 

leaving more space for the document.  
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Usage in math classroom – Math teachers read here! 
 

Although not specifically designed to be used in the classroom, the Math-o-mir has few features 

that can make it practical for that purpose. 

 

First of all, the Math-o-mir is small and low-resource software, therefore schools/students do not 

have to be equipped with up-to-date computers. A computer that barely runs Windows XP is 

enough. Second, the Math-o-mir itself is absolutely free software, being used inside the classroom 

or outside it. 

 

The Math-o-mir is an electronic notepad, and students can write math in a similar way they do 

using pencil and sheet of paper. However, a period of training is necessary. Teachers have to 

decide about the minimum age of students that are able to accept the software. 

 

Teachers are encouraged to send me their lists of suggestions and wishes in order to improve 

classroom usability of this software. 

  

Making math exams with Math-o-mir 

 

Teachers can create math exams using Math-o-mir. Exams are to be solved by students on their 

computers in electronic form. Math-o-mir uses public-key encryption scheme when dealing with 

exams to keep results produced by students secret. 

 

Teacher will create file with exam questions as any other Math-o-mir document. He/she can store 

this file privately as a standard file, but should take care that it doesn’t become available to 

students. 

 

Saving the exam file (teacher) 

 

Only the exam file that is saved as “MOM exam file” should be made available to students. To 

save the file as “MOM exam file”, teacher must use File->SaveAs menu option, and then choose 

“MOM exam file” from the ‘Save as type’ combo box: 
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After clicking the ‘Save’ button, teacher will be prompted to provide some additional data. 

Notably, the password and time limit: 

 

 
 

- password – here you must define the password. This password is not used to open the exam 

file (any student can open the exam file), but is used to open result files saved by students. 

Only teacher knowing the password can open result files. 

- time limit – define the time limit for the exam. Typically, students will receive warning 

message several minutes before the time elapses. Set the time limit to zero for non-limited 

exams. 

- disable calculator –completely disable all Math-o-mir computation ability. Students will not 

be able to use Math-o-mir to compute even most basic additions/substractions... 

- disable symbolic computation – only disables symbolic computation abilities of Math-o-mir. 

Computations involving pure numbers only are still possible. 

 

The exam file is to be saved at some place where all students can access it.  

 

Opening and solving the exam file (student) 

 

Being instructed to start the test, student will access and open the exam file. As soon as he/she 

opens it, the time will start running. 

 

Depending on the overall time limit, the warning message will be displayed to student several 

minutes before the time elapses, see the following table: 

 
Overal time limit Warning message 

>30 min 10 min before the time elapses 

11-30 min 5 min before the time elapses 

5-10 min 2 min before the time elapses 

1-4 min no warning message 

  

While he/she is doing the exam, the student will not be able copy/paste to/from other Math-o-mir 

instances. 

 

After the time elapses, the student will be notified that he/she should save his/her work. No further 

editing will be allowed! Note that student can save his/her work many times during the exam 

course, and this is even recommended because it decreases possible loses if the software crashes. 

Students should name their files according to rules determined by teacher. 

 
Software crash is a serious threat for students taking the exam. Teachers must prepare procedures for that case... If the 

software crashes, even if student saved his/her work just a moment ago he/she will not be able to re-open his/her work 

again (because of the password protection). Of course, student will be able to open the original exam file again and 

continue his/her work on further questions, taking care that his/her old file is not overwritten with the new one.  
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Reviewing results (teacher) 

 

Teacher can open any result file saved by students by providing the correct password.   

 

 
 

Each file with results is automatically subscribed with following data: 

- date and time of its creation 

- user name that was logged into computer and created this file 

- name of the computer that was used 

 

You will find this subscription data at the very end of the document. This data is provided in hope 

that it can help teachers if fraud is suspected. 

 

Reviewed results files can be saved as any other Math-o-mir file, and will not be password 

protected (unless teacher intentionally saves them in encrypted format). 
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Where to search for additional help 
 

If you need additional help, write to: 

 

 
  

You can also send bug reports and suggestions to above mail address. You can watch the progress 

of Math-o-mir development (and comment on every step) by visiting Math-o-mir blog at the 

following web address: http://mathomir.wordpress.com 

 

The Official Math-o-mir web site is at address: http://gorupec.awardspace.com/mathomir.html  

There you will find the latest downloadable Math-o-mir version, and latest news. 

 

 

You are free to distribute this document and use it in any way. 

 

Good luck, 

Danijel Gorupec 

Zagreb, 2017. 

 


